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1 FlowBreeze Help Introduction

FlowBreeze is a text-to-flowchart add-in for Microsoft Excel. It will allow

you to create great looking flowcharts, quickly and easily, just by typing.

If you are new to FlowBreeze, the best way to familiarize yourself with it

is to look through the Interactive Flowcharting Tutorial, which is the first

section in the table of contents, below. FlowBreeze works by automating

the built-in drawing tools in Excel. As a result, the topics covered in this

help file are a combination of FlowBreeze-specific features and built-in

Excel features. The flowcharts are generated using native Microsoft Office

shapes (also known as autoshapes).

Click here to get started on the tutorial



Toolbar Overview 7

© 2017 BreezeTree Software

2 Toolbar Overview

Because FlowBreeze is an Excel add-in, the FlowBreeze features are

accessible via a ribbon in Excel, as shown below.

FlowBreeze Ribbon

Feature Descriptions

· Flowcharting

o Start: Starts an interactive flowcharting session.

o Stop: Stops the interactive flowcharting session. This button is only

enabled when a flowcharting session is in progress.

o Settings:

§ Flowchart Settings: Opens the Settings window, allowing you to

customize the FlowBreeze flowchart rules and formatting.

§ File Locations: Opens a form that allows you to set the

directories for FlowBreeze files.

§ Import / Export Settings: Allows you to import or export

settings files for standardization among computers.

§ Export Symbol List: Exports the list of active symbols, along

with their prefixes and keywords, to a new workbook.

oWizard:

§ Flowchart Wizard: Scans the worksheet for text and loads it into

the Flowchart Wizard to convert into a flowchart.

§ Transpose Columns to Rows: Converts a vertical columns into

horizontal rows for left to right flowcharts.

§ Apply Parsing Syntax: Adds entry ID numbers, connector IDs,
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and branch label syntax to each entry.

o Templates:

§ Create a Template: Loads the Template Generator, which can

be used to create swim lane templates.

§ Create VSM Template: Load the value stream mapping

template generator.

§ Load a Template: Loads a template onto a new worksheet.

o Export

§ Export as Picture: Allows you to save the flowchart and/or

worksheet as a picture.

§ Export to Web Page: Creates an HTML file containing an picture

of the flowchart.

· Insert

o Add Shapes: Opens the Adds Shapes dialog to add a shape to the

worksheet.

o Add Connectors: Opens the Add Connectors dialog to insert one or

more formatted connectors between flowchart shapes.

o VSM Symbols: Opens the Value Stream Mapping dialog.

o Branch: Inserts a branch structure (like an organization chart).

oGroup Box: Inserts a background shape to label and encompass a set

of related shapes..

oDecision Blocks: Opens the decision blocks tool, allowing you

· Edit

oQuick Styles: Options to set color and lines styles in a single click.

o Edit Flowchart: Opens the flowchart editor, which allows you to

change shape types, content, and formatting.

o Find / Replace Text: Opens the Find / Replace Text in Shapes tool.
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o Style Gallery: A gallery of built-in shape formatting styles.

· Layout

o Layout (drop down):

§ Re-Align Shapes: Corrects any slightly jagged connector lines.

§ Align or Distribute: Align or adjust the spacing between multiple

shapes.

§ Order: If shapes overlap, you can use the Bring to Front, Send to

Back, Bring Forward, and Send Backward. to set how their are

layered.

§ Rotate: Change the orientation of a shape.

oGrid drop down:

§ Snap to Shape: Snaps a symbol to the edge of another flowchart

symbol.

§ Create a Grid: Changes the column width to match the row height,

creating a grid.

§ View Gridlines: Shows or hides the gridlines on the sheet gridlines.

§ Clear Shading: Clears any cell shading on the worksheet.

o Snap to Grid: Snaps the flowchart symbols to the worksheet gridlines.

· Select

oGroup:

§ Group: Creates one shape out of many.

§ Ungroup: Splits the grouped shape back into its constituent parts.

§ Regroup: If a set of shapes has been grouped then ungrouped,

they may be regrouped by selecting a single shape and clicking

this function.

§ Group All Shapes: In one click it will select all the shapes and

group then together into a single object.
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§ Ungroup All Shapes: In one click it will ungroup any grouped

shapes on the sheet.

o Select Objects (white arrow): Clicking it toggles a special mouse

cursor that allows you to select shapes. Must be toggled off after

use.

o Select:

§ Select All: Selects all the shapes on the page.

§ Selection Tool: Opens the Shape Selection tool.

§ Symbols: Selects only the flowchart symbols on the page (i.e., no

connectors, no labels, etc.).

§ Connectors: Selects only the flow line connectors on the page.

§ Labels: Selects only the labels on the page.

· Connectors

o Straighten: Converts any elbow connector that is jagged to a straight

connector

o Split: Replaces a connector with two labeled connector nodes.

o Crossover: Insert a crossover "bump" into the selected connector.

· Tools

o Symbol Key: Generates a symbol key (shape legend), listing all the

symbols used in your flowchart.

o Extract Text: Iterates through the flowchart symbols, extracting the

text and creating a list of the process steps.

oHyperlink: Add a hyperlink from a shape to another part of the

flowchart, to another document, or to a URL.

· Help

oOpen Help File: Opens the local version of this help file.
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o View Event Log: Opens the event log viewer to see any errors or

events that FlowBreeze has logged.

o Contact Support: Opens your email client to send a support ticket.

o Register FlowBreeze: Opens the registration form to enter your

license key.

o Check for Updates: Opens your web browser to the updates page to

check if there is a new version available for download.

o About: Shows the current version of the software.
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3 Interactive Flowcharting Tutorial

This tutorial will take you through the steps to create a flowchart using the

interactive flowcharting mode of FlowBreeze. Because FlowBreeze is an

Excel add-in, it will load with Excel but the interactive text-to-flowchart

generation remains idle until you start a flowcharting session. It will

operate on only one worksheet at a time, so you can start a flowcharting

session and switch over to another worksheet without fear that it will

inadvertently generate a flowchart symbol any time you edit the sheet.

Terminology

· Flow Line Connector vs. Connector Node: The word "connector" is often

used to mean the arrow that joins two shapes. However, it is also the

name for the nodes that show a jump from one place in the flowchart to

another. To disambiguate between the two meanings, connector arrows

are typically called "flow line connectors" or just "flow lines".

· Symbol vs. shape: The two terms are used interchangeability in the help

file and in FlowBreeze dialogs.

Start the flowcharting session

1.The first step to creating a flowchart is to click the Start button. If

you're running the trial version, you'll be greeted by a trial reminder

and will need to click the "Continue" button.

2.You will be prompted with the Start Flowcharting window. Click OK. (For

this tutorial, we will keep all of the default settings. For more

information on the options, see the Start Window section.)

3.FlowBreeze will generate a Terminator symbol, as shown below.
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Terminator symbol added

The cursor is positioned below the symbol, ready for the next entry. Also,

the Start Flowcharting button is now disabled and the Stop Flowcharting

button has become enabled.

Add symbols

FlowBreeze watches for changes in worksheet content to generate

symbols. Anytime you edit a cell, that will trigger a "change event". These

change events are what FlowBreeze monitors to know that it needs to kick

into action. In this step, we will show you three things:

· Using the basic text-to-symbol technique.

· Creating a symbol using a keyword.

· Creating a symbol using a prefix.

Type "step 1" into the cell and press Enter. As show below, FlowBreeze

generates the default flowchart symbol - a process shape (rectangle). Also

note that the first letter of "step 1" was automatically capitalized.
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Next, we will generate a symbol using a keyword. Keywords are special

words that you assign to symbols and can be customized in the Settings

window. The word "read" is preset as a keyword for the data symbol, so

you can type "read data" into the next cell to create the Data symbol, as

shown below.

    

Now, we will generate a symbol using a prefix. Like keywords, prefixes are

special entries that you assign to specific symbols and can be customized
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in the Settings window. Prefixes are placed at the start of an entry and

must end with a "prefix delimiter". The delimiters can be customized on

the General tab in the Settings window.

Enter "doc:print file" in the next cell. Since "doc:" is preset as a prefix for

the Document symbol, the prefix is stripped out from the entry and just

the words "Print file" are placed in the Document symbol.

    

Creating a decision symbol

Decisions are symbols that indicate a fork in the process. One feature of

FlowBreeze is that any entry containing a question mark (?) will generate

a Decision symbol and branch labels, e.g., Yes/No, Pass/Fail, etc.

Enter the text "requires step 4?".
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FlowBreeze will add the Decision shape and prompt to add branch labels. (

Note the default right label is "No" and the default bottom label is "Yes").

The labels are then added next to the decision, as shown below. You can

disable this feature or change the default labels in on the Decisions tab of

the Settings window.

Manually adding labels

For the decision, you were prompted to add labels, but there are times

when you might want to add a label yourself. These are covered in detail

in the Insert a Label section.

Adding connector nodes
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On-Page Connector nodes are circles that show a jump from one part of

the flowchart to another. On the General tab of the Settings window,

FlowBreeze can be configured to add a connector node when a 1 or 2

character ALL CAPS entry is made (e.g., A, B, AA, B1).

In the "Final sample flowchart" picture below, we added a "Step 4" in the

same way we added "Step 1". Then we entered "A" in cell C30 (after Step

4) to create a connector node. The connector node is automatically

centered to the shape above it.

We will now continue the flowchart in column Q of the worksheet. To show

continuance, another node is added by typing "A" in cell Q3. Once again,

the connector node is added and then centered based on the standard

shape width. This will position the second A node in cell T3.

Adding Connectors (aka, arrows or flow lines)

In most cases, FlowBreeze will automatically detect the last shape and

add the connector arrow. However, if FlowBreeze cannot detect which

symbol you want to add a connector from, it will prompt you with the Add

Flow Line Connector window. This short tutorial doesn't demonstrate that,

but you can see the Flow Line Prompt section for more details.

In other cases, you may want to manually add a connector. To

demonstrate, type "step 5" in cell Q7 to create a new shape. Now we're

going to add a connector from the "No" branch of the decision "Requires

step 4?" by using the Add Connectors task pane by following these steps:

· Click Add Connectors from the FlowBreeze toolbar.

· In the From Shape column, select "Requires step 4?"

· In the To Shape column, select "Step 4".
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· Click the Add Connector button on the task pane.

A new connector will be added between the shapes, as shown in the "Final

sample flowchart" picture below. 

Stop the flowcharting session

To end the interactive flowcharting session, click the Stop button on the

toolbar. Before you stop flowcharting, it's a good idea to select the cell

where you want to place the stop Terminator. FlowBreeze will use this as

the default location to place the Terminator symbol. In our example, you

will place it beneath "Step 5".

Upon clicking the Stop button, FlowBreeze will display the "Add End

Terminator?" window, shown below. In this window you can change the

text (with the option to make the new text the default for the next time

you flowchart), and you can change the cell where the Terminator should

be added by clicking the Select Cell button. When you click Yes, the

Terminator is added and the flowcharting session is completed.

Once the session is topped, FlowBreeze will no longer generate symbols

from your entries, meaning you can go back to using the worksheet for

normal Excel activities.

Add end terminator window
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Final sample flowchart
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3.1 Start Window

When you click the "Start" button, FlowBreeze will prompt you for a few

options before the flowcharting session begins.

Drawing Area

The Drawing Area section lets you specify how you want the worksheet to

look when you are flowcharting. The settings are described as follows:

· Create a grid: Changes all column widths to match the row height,

creating a grid on the sheet.

· Preserve existing sheet layout: Leaves worksheet as-is, and not change

the column widths.

· Load a template: Loads a template. Templates are covered in the 

Template Generator section of the help file. If you choose to load a

template, it will be added as a new worksheet in the current workbook.

Start Terminator

· Add a terminator to the beginning of the flowchart: Adds a Terminator

symbol to the start of your flowchart.

· Terminator text: As implied, it's the text to appear in the Terminator

symbol, e.g. "Start".

· Worksheet cell: The location on the sheet where the terminator will be

placed. Click "Select cell" to change the location. If you choose Load a

template, there is a good chance that you need to change this cell,

especially if your template has swim lanes.

Tip: It's worth noting that the first step in a flowchart does not need to

be generic text such as "start" or "begin". Many flowcharting tutorials

advise that the first step be the "trigger action" that kicks off the

process. However, at their core flowcharts are communication tools,
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and if your flowchart will be read by a general audience, keep in mind

that many people viewing it may never have read a flowchart. They

may have no idea what a trigger action or a terminator symbol is.

Instead, they'll be scanning the diagram trying to figure out where the

process starts. So matching the text to the audience is advised.

Page Settings

If you click "Page Settings" a sub-dialog will open a sub-dialog for setting

the paper size and orientation, as well as the following two options:

· Hide Excel gridlines: This will create a plain white background, hiding

Excel's built-in row and column gridlines.

· Show entry guidelines: When you are flowcharting, FlowBreeze will

shade a horizontal row and vertical column to indicate where the next

line of text should be entered. If you enter your text along a shaded line,

the symbols will be automatically aligned and a flow line will be added

automatically as well. Note: If you select this option, any shading on

the worksheet will be cleared.

Start

When you click the OK button, this window is closed and a flowcharting

session will begin.

3.2 Flow Line Prompt Window

When you're working with FlowBreeze in interactive flowcharting mode,

connectors (flow lines / arrows) are added from the last shape to the new

shape automatically. However, there are some cases where FlowBreeze
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will not automatically add a flow line:

· The new shape is not in the same row or column as the last shape.

· There is a 3rd shape in between the last shape and the new shape.

· You delete the last shape created.

· Flowcharting was stopped and then re-started.

Whenever any of these cases occur, FlowBreeze will prompt you to add a

flow line, as shown in the image below. The list contains the all the

flowcharting shapes contained on the worksheet, along with an icon

showing the symbol type, the worksheet location of the symbol, and the

text (if any) that it contains.. The items are sorted by the distance from

each symbol to the newly added symbol.

How to Use

1. Select the text of the shape to connect from.

2. Optionally, click the "Line Properties" toggle button and customize the
line style and connection settings.

3. Click OK to add the connector or Cancel if you don't wish to add one.
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4 Flowchart Wizard

The Flowchart Wizard is a tool that transforms a sheet of text into a

flowchart in just a few steps. With it, you can enter all the process steps

into worksheet cells, and the Flowchart Wizard will load all the text into a

form that lets you assign symbol types, formatting, and flow line routings

to each process step. It will then generate a flowchart from that

information. You may need to make some adjustments to the flowchart

layout and flow line routings, but overall it cuts the time to create a

flowchart considerably.

Pre-Layout

Before running the wizard, layout the text for the flowchart on the sheet.

The picture below shows a sample worksheet with the text for the process

steps entered into cells. When you enter the process text, the goal is to

arrange it roughly how you want the flowchart to be organized. The

wizard allows for two types of input - normal (shown below) and parsed,

which allows for advanced control over connector routings. (See Parsing

Rules for more detail.)

Picture 1 - Sample Flowchart Text

Running the Flowchart Wizard

Click Flowchart Wizard > Flowchart Wizard on the toolbar to launch
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the wizard. The first page of the wizard dialog allows to set some

preferences for the flowchart.

Step 1 - Set Options

· Input Text Source: FlowBreeze gets the text for the flowchart steps off

of the currently open worksheet. If you only want to use some of the

text, click "Only text from range" and then select the range to import the

text from.

· Template Settings: If you are using a swim lane template, this option

helps ensure that the flowchart will be generated in the current lanes.

See using the Flowchart Wizard with Templates page for more details.

· Input Text Options:

· Ignore Keywords: If checked, all entries will be set to Process symbol

types (i.e., rectangles) by default.

· Replace | character with line break: When checked, the wizard will

put a hard line break wherever "|" is encountered. (The | character is

commonly called a "pipe" and is located above the "\" character on

the keyboard.)

· Add default decision branch labels: If checked, the default branch

labels specified in the Settings will be added to the output. If

branches are specified in either the input text or the connector

section of Step 2 (below), then the defaults will not override them.

· Flowchart Layout: 

· The "Top to bottom" and "Left to right" options determine the default

routing direction of the connectors.

· Uniform Symbol Height: For left to right flowcharts, you can choose

to make all the symbols the same height.

· Connector style: Choose the style for the connector lines from the

drop down. (The styles for the shapes are set in Step 2 of the
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wizard.)

· Spacing Between Shapes: 

· The Rows and Columns settings specify the minimum spacing

between shapes.

· If you are using a swim lane lanes, the Columns setting is ignored for

vertical swim lanes, and the Rows setting is ignored for horizontal

swim lanes.

· Selecting "Keep existing layout" will prevent the wizard from adding

any additional spacing between shapes.

· Flowchart Output: 

· You can choose to output to the current worksheet or have

FlowBreeze generate the flowchart in a new sheet, preserving the

original content.

· If you overwrite the existing sheet, you can check the option to keep

the existing shapes. This is useful when using templates with the

wizard.

· Link shape text to input cells: If checked, the content of each shape is

linked to it's original cell. If the text in the cell is changed, the shape's

text will update automatically.

Step 2 - Set Symbols, Styles, and Connectors

When you click Next >, the Flowchart Wizard will display all the entries

in Step 2. This step allows you to edit the text, change the symbol type,

change the style, and add connectors and branch labels for each entry.

Entry list

· ID: This column is for reference when setting the Connectors. If you do

nor use the advanced parsing syntax, the ID numbers will auto-

generated.
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· Symbol: This column shows the symbol type assigned to the entry.

· Style: This column shows the style assigned to the entry.

· Text: This is the text that will be placed into the symbol. If any mistakes

were made on the original sheet, they can be corrected here.

Edit Symbol and Styles

Beneath the entry list are two images showing the symbol and the

formatting style for the currently select entry. Clicking the button beneath

either will prompt for a new symbol or style, respectively.

Connector Arrows

This list allows you to specify outgoing connectors for each item. When

you click the + button, a new line is added to the connector list, with the

following fields:

· Connect To: Allows you to set the ID to route a connector arrow to.

· Side: Specify the side the connector will be routed from. (required if

branch label is set, otherwise optional)

· Branch Label: Specify a label placed next to the connector. (optional)

Generate flowchart

Click OK and the wizard will generate a flowchart. Some shapes may need

to be repositioned to achieve the layout you desire.

Related Topics

· Transpose column to rows tool

· Apply parsing syntax tool

· Editing tips
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· Moving Symbols 

· Working with Flow Lines

· Using the Flowchart Wizard with Templates

4.1 Parsing Rules

The Flowchart Wizard accepts a syntax that allows for parsing to set connectors and branch labels.

The basic syntax is Id, Entry Text, Connector(s), where each part is defined as follows:

Entry Id: A unique number. (optional)

Entry Text: The text that will go into the flowchart symbol. (Required)

· The text can contain Prefixes and Keywords.

· Text containing commas should be enclosed in quotes, as in "This is

an entry, and it has a comma."

· Line breaks can be inserted into the text by placing a "|" character at

the breakpoints.

Connector(s): (Optional) One or more Id's to connect a line to.

· Connectors can simply be a comma separated list of the Entry Id's

that you want to route a connector to.

· Connectors can also include the connection sides and branch labels

separated by colons, as in connect_to_id: side: label.

· The acceptable sides are top, right, bottom, and left, and they can be

abbreviated t, r, b, and l, respectively.

· If the label contains a comma, the label portion must be enclosed in

quotes.

Hyperlinks: (Optional)

· The hyperlink must be in the form "link:address", where address is a

URL, external file, or location within the current workbook.
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· If linking to another file, you must use the full path to the link.

· If the link is a URL, accepted formats include http://, https://, ftp://,

and mailto:.

Technical note on Entry Id

The Entry Id is just a placeholder using to map any connector entries. The

Flowchart Wizard imports the data from the spreadsheet and stores the

information along with the row and column of each entry. On the first

screen of the wizard, you can set the flow direction - top to bottom or left

to right. Based on this direction, the data is sorted either by column then

row or row then column. The ID's shown on the second step of the wizard

are based on the sort order.

Accepted formats

Format Notes

text Automatically assigns id;

assumes connector routes to

next entry

text, connect_to_id Automatically assigns id; if you

specify a connect_to_id, the

corresponding id must be

specified for another entry.

id, text Assumes connector routes to

next entry

id, text,

connect_to_id

id, text,

connect_to_id,
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connect_to_id,

connect_to_id, ...

id, "text, that includes

a comma",

connect_to_id

(Safe) Most of the time,

FlowBreeze can detect commas

included in text passages versus

the commas that delimit the

sections of the parsing syntax,

but enclosing this text in quotes

will ensure that it is parsed

correctly

id, text that includes |

a line break,

connect_to_id

The '|' symbol will be replaced

with a hard line break within the

flowchart shape

id, text,

connect_to_id,

connect_to_id, ...

id, text,

connect_to_id:side:

label

id, text,

connect_to_id:side:

label, connect_to_id:

side:label, ...

..., link:address A link can be added after any of

the above formats, and it must

be the last segment of the entry

Examples
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Example Description

Unload pallet and

stock items

Creates a process step. When

loaded, the wizard will assume a

connector will be routed to the

next step.

2, Unload pallet and

stock items, 3

Creates process step connecting

to step 3

2, Unload pallet |

stock items, 3

Creates process step connecting

to step 3, with a hard line break

placed as follows:

Unload pallet

stock items

2, Unload pallet and

stock items, 3, 7

Creates process step connecting

to steps 3 and 7

2, "Unload pallet, and

stock items", 3

Creates process step with

embedded comma connecting to

step 3

7, Is shipment in

system?, 8:bottom:

Yes, 3:left:No

Creates decision symbol

connecting to steps 8 and 3.

The connector to step 8 comes

out of the bottom of the

decision symbol and is labeled

"Yes". The connector to step 3

comes out of the right side of

the decision symbol and is

labeled "No". 
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Unload pallet and

stock items, link:

Sheet2!A1

Creates a process step, and

clicking on the shape will

navigate to the address (in this

example, it would go to cell A1

on Sheet2).

4.2 Transpose Column to Rows

The Transpose Columns to Rows feature will take a vertical column (or

columns) of entries on the worksheet and transpose it into a series of

horizontal rows. This tool is intended as a pre-processor for the Flowchart

Wizard, to allow you to easily layout out the entries for a left to right

flowchart before running the wizard.

Fields

· Number of columns: This field determines how many entries will be

placed in each horizontal row. The two pictures below show the process

steps before and after transposing columns.

· Output Location: Option to preserve original content or overwrite it with

transposed content.

Before Transpose Columns to Rows
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After - Number of columns = 3

4.3 Apply Parsing Syntax

The Apply Parsing Syntax tool will take plain text entries and add entry

ID's, connector ID's, and branch label syntax.

Why Is This Tool Needed?

Running this tool is not required before using the Flowchart Wizard.

However, it is useful for complex processes. By applying the parsing

syntax before running the Flowchart Wizard, you can edit the connector

routings and branch labels on the worksheet instead of in the Flowchart

Wizard dialog. Spreadsheets are easy to edit, so applying the syntax

before running the wizard makes fine tuning the entries much easier.

Fields
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· Direction: This determines how the entries on the worksheet will be

numbered.

· Output: You can output the parsing syntax to a new worksheet or

overwrite the existing one. There is no undo operation if you overwrite

the existing sheet, so outputting to a new worksheet is a recommended

precaution.

Example

The following picture shows a simple process before running the Apply

parsing Syntax tool:

Sample process steps before applying parsing syntax

After running the tool, the text has been transformed as shown in the

following picture:

Process steps after applying parsing syntax

Things to note in the above picture:

· Each entry has an ID placed before the text.

· Each entry has connectors identified after the text.

· Any entries containing commas are enclosed in quotes.

· Decision shapes have default connector and branch label syntax added.
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· There is a comment added to the Decision cell stating that it will need to

be edited, because there is no reasonable way for FlowBreeze to guess

where the decision branches should be routed.

Decisions need to be edited:

Entry 90: This tool assumes that you will want at least two lines routed

out of a decision shape. It adds two stubs, both pointing to the next entry.

In this example, we replaced the "100:right:No" connector with "80:right:

No", in order to generate the sample flowchart below.

Example Output

Finally, we can run the Flowchart Wizard, and the wizard will generate the

following flowchart:
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Generated Flowchart

4.4 Using the Flowchart Wizard with Templates

There are several additional steps that need to be done to ensure that the

resulting flowchart layout works when using the Flowchart Wizard with a

template.
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Shape Width

If the you are using a Letter sized template (8-1/2x11 or A4) with three

or more swim lanes, you may need to change the default shape width in

the FlowBreeze settings. For example, a 3-lane template generated for a

letter-sized page will have lane widths of 10, 10 and 9. The means that

the smallest lane (9 grid columns) will accommodate a shape width of 7

(with a one column padding on each side).

To change the maximum shape width:

· Click Settings from the FlowBreeze toolbar.

· On the symbol List tab, click "Edit Dimensions".

· Change the Width setting and click OK to close the Dimensions form.

· Click OK on the Settings form. 

Input

The image below shows the text in a swim lane template pre-arranged

prior to running the Flowchart Wizard. For best results:

· For the shape to be generated in a given lane, the text should be in

that lane.

· The text should be offset within the lane to ensure that the left or top

edge of the shape does not abut the swim lane diver lines.

· You do not have to space the rows apart as they are shown below,

but typically the more finely tuned the input arrangement, the less

you will need to adjust the layout after running the wizard.
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Running the Flowchart Wizard

In Step 1 of the wizard, you will need to check the "Input uses a swim

lane template?" option. This will result in the flowchart being added to the

existing template sheet instead of a new worksheet. Note: In the Spacing

Between Sheets settings, the Columns setting is ignored for vertical swim

lanes, and the Rows setting is ignored for horizontal swim lanes.

The remainder of the wizard operations are the same as running it without

a template.
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5 Value Stream Mapping

Value Stream Mapping tools can be accessed via the VSM Symbols button

on the FlowBreeze toolbar. In addition to the VSM symbols, FlowBreeze

also features a VSM Template Generator, which is covered here. 

Accessing the Value Stream Mapping Symbols

Clicking the VSM Symbols button opens the Value Stream Mapping

Symbols dialog. To add a VSM symbol to the worksheet, follow these

steps:

1.Select the worksheet cell where you want the symbol to be placed. For

Value Added-Time and Non Value-Added Time blocks, the selection can

span multiple cells.

2.Click on the symbol to add.

3.If there are any Options associated with the symbol, enter them as

needed.

4.Click the Add Symbol button on the dialog.

Notes:

· If a symbol has no Options associated with it, you can simply double-

click the icon to add it to the worksheet.

· The symbol text font is set in the Settings screen.

Available symbol set

FlowBreeze features Operations, Inventory, Movement, and Data symbols,

as shown in the images below.

Operations Symbols
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Inventory Symbols

Movement Symbols
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Time Data Blocks

 

VSM Symbol options

When you click one of the symbols above, the following options fields are

shown based on the symbol type.

· Title and text: Production Control and Process symbols have separate

title and text fields.

· Text: numerous shapes allow you to add text.
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· Angle: You can preset the angle for arrows. Clicking the angle selector

will snap to 45 degree increments, and dragging the selector will snap to

5 degree increments.

· Data table size: set the number of rows in the data table.

· Pull arrow direction: set the direction to left-to-right or right-to-left.

Clear Formatting: The timelines and data tables are created by formatting

cells with borders and shading. As the name implies, the Clear Formatting

button clears the borders and shading.

5.1 VSM Template Generator

To create a Value Stream Mapping template click Templates > Create

VSM Template from the toolbar. The VSM Template Generator allows you

to design reusable Value Stream Mapping templates.

Template Properties tab

· Template name: The file name that the template will be stored as.

· Template folder: The folder that the templates will be stored in. The

default location is "\My Flowcharts\Templates" under your Documents

folder. FlowBreeze does not use the built-in template folder in Excel

because that folder is hidden in some versions of Windows.

· Paper size: supports 11x17, A3, 8.5x11, and A4 paper sizes. The page

orientation is always landscape.

· Font: Sets the font for the title block fields and swim lane labels.

· Line style: Sets the line color and thickness for the title block and swim

lane outlines.

· Hide Excel gridlines: Toggles off the gridlines on a worksheet.
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Title Block tab

The title block tab is the same as in the Flowchart Template Generator.

· Select header: Clicking this will open the Select Header window shown

below left. In this sample, we've selected the "3 fields w/ logo" option.

· Select footer: Clicking this will open the Select Footer window shown

below right. In this sample, we've opted for no footer.

· Import logo: Clicking this will allow you to import your logo into the

template. Logos are automatically resized to fit the available space.
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VSM Symbols

The VSM Icons tab lets you preset basic symbols, including supplier,

production control, customer and process symbols. The maximum number

of process symbols for each template is set based on the paper size.

Below each process symbol, you can choose to add data tables and

timeline segments. Value-added timeline segments are added below the

processes, and non value-added timeline segments are added between

each symbol.
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6 Template Generator

(Note: The Value Stream Mapping Template Generator is covered here.)

To create a template click Templates > Create Template from the toolbar.

The Template Generator allows you to design flowchart templates,

including cross functional (swim lane) layouts. The Template Properties

and Title Block settings are saved between uses. Once they are set, new

templates can be created very quickly.

Template Properties tab

· Template name: The file name that the template will be stored as.

· Template folder: The folder that the templates will be stored in. The

default location is "\My Flowcharts\Templates" under your Documents

folder.

FlowBreeze does not use the built-in template folder in Excel because

that folder is hidden in some versions of Windows.

· Font: Sets the font for the title block fields and swim lane labels.

· Line style: Sets the line color and thickness for the title block and swim

lane outlines.

· Generate template outline using ...

o Shapes: This option is better if you want to copy and paste the

flowchart into another document.

o Cell formatting: This option makes the template easier to manually

edit.
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Title Block tab

· Select header: Clicking this will open the Select Header window shown

below left. In this sample, we've selected the "3 fields w/ logo" option.

· Select footer: Clicking this will open the Select Footer window shown

below right. In this sample, we've opted for no footer.

· Import logo: Clicking this will allow you to import your logo into the

template. Logos are automatically resized to fit the available space.
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Swim Lanes tab

· Template Type: click the option for the type of flowchart you wish to

create - vertical swim lanes, horizontal swim lanes, SIPOC, or just a

plain grid with a title block. Note, SIPOC  (Suppliers, Inputs, Process,

Outputs, Customers) is a special layout with a open area in the center

for creating the flowchart.
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· Paper size: FlowBreeze supports 8-1/2x11, legal, 11x17, A3, and A4

paper sizes. Important: your printer must support these page sizes in

order to properly set the page properties.

· Orientation: Select portrait or landscape.

· Swim Lanes:

· Enter the text for each lane label then click the "Add lane" button.

The text can be left as generic (e.g. "lane 1", Lane 2", etc.) and

changed after the template is loaded at the time of use.

· Or, select a set of swim lanes from the drop down list.

· The "Max. recommended number of lanes = " shows the number of

lanes that will fit inside a single page boundary for the paper size and

orientation you have selected.
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6.1 Load Template

Where are the templates?

When FlowBreeze first runs, it will create a My Flowcharts folder in your

Documents folder and place any templates you've created in a Templates

sub-folder.

Loading templates

Templates can be loaded two ways:

· Via the toolbar: Click Templates > Load Template button to launch the

Select Template File dialog below.

· Via the Start Flowcharting window: Under the Drawing Area section,

choose the Load a template option.

After clicking Open, the template will be loaded into a new worksheet.
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Naming convention for pre-made templates

Pre-made templates can be downloaded from the breezetree.com web

site. (although, we recommend creating your own flowchart templates).

The pre-made templates pack a lot of information into the names. The

syntax is:

page size - orientation - number of lanes - lane direction - "lane flowchart"

· Paper size: The Template Generator supports 8.5x11, 11x17, A3, and

A4. You can manually create other paper sizes.

· Orientation: P = portrait and L = landscape.

· Number of lanes: Number of swim lanes.

· Lane direction: V = vertical (top to bottom) and H = horizontal (left to
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right).

Example: 8.5x11-P-2-H-Lane-Flowchart would be read 8-1/2 x 11 Portrait

2 Horizontal Swim Lane Flowchart.

Related

· Template Generator - how to create a template using FlowBreeze.

· Creating Custom Templates - how to manually create a template

(without the Template Generator).

6.2 Create Custom Templates

The Template Generator automates the process of creating cross-

functional, swim lane templates, but if you need more customization this

section covers how to manually create your own templates. 

FlowBreeze allows you to load custom templates via the Load Template

toolbar button or at the start of a flowcharting session in the Start

Flowcharting window. In addition to cross functional flowcharts (a.k.a.

swim lane diagrams), you can also create simple templates for title blocks

or block diagrams.

Step-by-step instructions

1. Create a grid.

2. Turn on Snap to Grid and Snap to Shape.

3. Set the page properties for paper size, orientation, and margins as

desired via the Page Layout tab on the ribbon.

4. Type anything into a cell and do a print preview in Excel. Then close the
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print preview. This will display the page breaks, giving you a visual

boundary for the template layout. Delete the entry you typed.

5. Get access to the Excel Drawing tools via the Insert tab. For the steps

below, you will need to click the Shapes drop down while on the

FlowBreeze tab.

6. Use a rectangle shape to add any title blocks to the diagram. Apply text

formatting with the built-in formatting tools in Excel. If you wish to add

swim lanes, add those beneath the title blocks.

Note: Keep a margin of one grid space between the title block and the

left, right and bottom page break lines. The border lines will not display

when printed if they are directly on the page break line.

7. Add any vertical lines for borders and swim lanes. Use the plain Line

available from Excel's drawing tools.

8. Rename all the shapes, so that each shape name starts with

"TEMPLATE_". This is critical to integration with FlowBreeze because it will

treat these shapes specially. To rename a shape, click on it, then rename

it in the Name Box, as shown below. The picture shows the Excel 2007

Name Box, but it's in the same location in other versions of Excel.

Note that no two shapes can have the same name. This must be done

for both shapes and lines.

9. Click Group > Group All Shapes from the FlowBreeze toolbar.
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10. Repeat step 8 and name the grouped template shapes

"TEMPLATE_GROUP".

11. Save as an Excel template file (i.e. an .xltx file type).
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7 Settings

When you click the Settings button on the toolbar, the FlowBreeze

Settings window will open. The first tab allows you to set the properties

for the active Symbol List, shown in the picture below.

Symbol List

· Symbol: A icon of the symbol - cannot be edited in the grid.

· Style: A small icon of the style set for the symbol - can be changed via

the drop down list in the cell or by clicking "Edit styles" (detailed below).

· Name: This is the name of the symbol that will be displayed when you

generate a Symbol Key. Click to edit.

· Prefix: An abbreviation of the symbol name. Click to edit. Important:

keywords must be separated by commas. (See also: Using Keywords

and Prefixes).

· Keywords: Words, that when used in an entry, will generate the symbol.

Click to edit. (See also: Using Keywords and Prefixes).

· Width: The width for the selected symbol. The grid units are based on

the default row height in Excel. (See "Edit dimensions" below).

· Height: The minimum height setting is similar to the width setting. By

default, FlowBreeze will auto-size the height of the symbol to fit the text.

(See "Edit dimensions" below).

Other controls on this tab

· Move Up / Move Down buttons: FlowBreeze will check your flowchart

text entry against the keywords in the list. The keywords are evaluated

in the same order as the symbols in the list, so if a text entry has

keywords matching two or more symbols, the symbol that appears first

in the list will be created.
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· Disable keyword mappings: If checked, keywords will be ignored and

entries will generate Process symbols by default.

· Edit symbol list: Allows you to add or remove symbols from the active

list of symbols used in flowcharting.

· Edit styles: Opens the Symbol Styles window for bulk style changes to

one or more symbols.

· Edit dimensions: Opens the Set Symbol Dimensions window. The

dimensions set in this dialog will affect all symbols.

7.1 Settings - General

The General tab of the Settings windows has the following sections,

which reference the screenshot below.

Terminators and Connection Nodes

Terminators are the oval flowchart symbols used to designate the start or

end of a process boundary. Connectors come in two types - On-Page and

Off-Page. the On-page Connectors are labeled circles used to designate a

jump from one part of the flow diagram to another. Similarly, the five-

sided Off-Page Connectors are used to designate a jump to a process step

on another page (assuming a multi-page flowchart). The available settings

for these symbols are:

· Prompt to add an end Terminator: If this setting is enabled, FlowBreeze

will prompt you to add a an end Terminator. The prompt window allows

you to enter the text and select the location to place the terminator

symbol. Note, when you click the Stop Flowcharting button FlowBreeze

will scan the symbols on the drawing and look for any terminators
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already labeled "stop", "end", or "done". If it finds one, it will not prompt

you to add another one.

· Generate On-Page Connector nodes for entries with 1 or 2 ALL CAPS

characters: If checked entries such as A, B, AA, A1 will generate an On-

Page Connector symbol.

· Generate On-Page Connector nodes for numeric entries: If checked

entries such as 1, 2, 3, 1000, etc. will generate an Off-Page Connector

symbol. If the Off-Page Connector field is unchecked, then numeric

entries will generate an On-Page Connector.

Default Process Shape

This option allows you to set whether the default shape is a rounded

rectangle or a regular rectangle (with squared corners).

Symbol Text

· Automatically capitalize first letter: Text like this - "sample entry", will

become this - "Sample entry".

· Text Alignment: Set the vertical and horizontal alignment of the text.

· Prefix delimiter: Determines the separator between prefixes and text

entries. See Prefixes and Keywords for more detail.

· Font: The font used for the flowchart symbol text. Tahoma 8 is used by

default because it produces clear, readable text at a smaller font size,

allowing more words to fit within a shape. Calibri and Segoe UI also are

suitable fonts for clear, readable text at small font sizes.

Symbol Size

· Autosize symbol height if it exceeds default height: The heights set in

the symbol list are minimum heights. If checked this will autosize the

height. If you prefer to have fixed heights, it's recommend that you



FlowBreeze 4 Help File58

© 2017 BreezeTree Software

uncheck this box and set the heights in the symbol list to a uniform

value.

· Smart Sizing for On and Off-Page Connectors: If checked, this will keep

the connector node shapes as small as possible.

· Allow text to overflow shape: (Excel 2010 - 2015 only): If the text is too

long to fit within the shape, this setting allows the text to go beyond the

shape borders. Although this cannot be set in Excel 2007, if a flowchart

is created in Excel 2010 or newer and viewed in Excel 2007, it will

render correctly. This setting is lost if the file is saved as an Excel 97-

2003 .xls format.

Spacing Between Shapes

· Sets the grid spacing between the shapes.

7.2 Settings - Decisions

The Decisions tab of the Settings window has the following sections,

which reference the screenshot below.

Decision Options

· Create Decision symbol for entries containing "?": If an entry contains a question mark,

checking this option will make FlowBreeze create a Decision symbol.

Branch Label Creation

Decisions are the diamond-shaped symbols used to indicate branches in

the process, and the branches usually have labels next to the connectors

to indicate the path differences.
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· Automatically add branch labels: Branch labels are added to Decision

symbols without prompting.

· Prompt for branch labels: Every time a Decision symbol is generated,

you will be prompted for the branch labels.

· Don't add branch labels: No branch labels will be added.

Branch Label Position

· Branch label position: You can choose to have the branch labels

centered over the flow line, or offset to the side.

Branch Label Text

· Branches often have labeled flow line connectors coming out of them -

one for each possible decisions. It is considered good flowcharting style

to keep the directions consistent, e.g. "Yes" always going down and "No"

always going to the right.

· The top, right, bottom, and left branch label entries are the default

labels to add to their respective sides. If you choose the "Automatically

add branch labels" option above, these labels will be added. If you

choose the "Prompt for branch labels" option above, these values will be

pre-filled on the prompt window. If the text box for a side is empty, no

label will be added.

Label Formatting

Note: For consistency, the label formats set here apply to all labels

created by FlowBreeze, not just branch labels.

· Transparent background: In case the label edges overlap the

connectors, a transparent label background lets the connector line

remain visible.

· Use different font for branch labels: If checked, you can set a different
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font and color for branch labels.

7.3 Settings - Connectors

The Connectors tab of the Settings window has the following sections,

which reference the screenshot below.

Flow Line Connector Options

· Automatically add flow line connectors : FlowBreeze will automatically

add flow lines when from the last symbol if this is checked. Also, if you

restart flowcharting, or if the new shape is not aligned or adjacent to the

last shape, then FlowBreeze will prompt you to select the shape that you

want to route a flow line from. If this setting is unchecked, no flow lines

are added.

· Dashed lines in/out of Alternate process shapes: Some processes have

alternate paths. To indicate this, you can check this setting to make flow

lines routed to or from Alternate process shapes be dashed.

Flow Direction

After you create an entry, FlowBreeze will replace it with a shape, then

position the cursor to the next logical place on the sheet. the Flow

direction setting determines whether the placement is below the last

shape or to the right of the last shape. If you choose "Let FlowBreeze

detect direction" it will wait for two consecutive shapes in any direction

and place the cursor accordingly.
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Line Type for non-adjacent shapes

· You can select straight, elbow, or curved. When shapes are aligned and

adjacent, a straight connector is used.

Connector Format

· Arrowhead Begin and End: Sets the arrowhead for the beginning and

ending of the line.

· Arrowhead size: Sets the width and length of arrow.

· Color: Sets the color of the flow line connector arrows.

· Thickness: Sets the line thickness of the flow line connectors.

· Remove line shadow: (recommended) Checking this box removes the

shadow from the flow lines. Some of the Excel built-in styles feature a

shadow on the lines. The shadows look good on screen but often look

blurred when printed or when the flowchart is exported to an image file

or saved to PDF.

Shape Borders

· Set shape border thickness to match connector line thickness:
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8 FlowBreeze Tools

The following tools are available in FlowBreeze to help automate

flowcharting tasks:

· Add Connectors

· Add Shapes

· Apply Styles

· Clear Shading

· Create a Grid

· Create a Symbol Key

· Export as Picture

· Export to Web Page

· Extract Text

· Find / Replace Text

· Flowchart Editor

· Insert Branch

· Insert Decision Blocks

· Insert Group Box

· Re-Align Shapes

· Select Shapes Tool

· Split Connector into Nodes

· Straighten Connectors

· Symbol Styles

· View Gridlines
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8.1 Add Shapes

Clicking Add Shapes on the toolbar will open the Add Shapes dialog. The

symbol style and font formatting is based on the configuration set in the 

Settings window.

Steps

1.Select the cell where the symbol is to be placed.

2.Click on the symbol type from the gallery.

3.Type the text to appear in the symbol.

4.Click the "Add Shape" button.

Shortcuts

· Instead of clicking the "Add Shape" button, you can press Enter after

typing the text.

· You can double-click on a symbol image to add the shape. If the Text

field is empty, a blank shape is added.

Options

· Auto-detect shape type: If checked, as you type the entry in the Text

field, FlowBreeze will select the shape type from the gallery above.

Supports Keywords and Prefixes.

· Add connector from previous shape: If checked, will add a flow line

connector from the last shape added (if one exists and can be detected).

· Override default styles: When checked, you can customize the shape

style and font.

Notes

· Each symbol section is collapsible.
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· Press x in the upper right of the panel to close it.

· Press « in the upper right to collapse the panel to the left edge of Excel.

8.2 Clear Shading

The Clear Shading tool will clear all the shading on the worksheet,

including any of the gray guidelines that might be on the sheet. Normally

when a flowcharting session is stopped, the gray guidelines are cleared

automatically. However, if you close the workbook or print during a

flowcharting session, the session will be interrupted and the shading may

not be reset.

8.3 Create a Grid

The Create Grid feature will adjust the widths of all the columns to match

the default row height. It can be accessed from the FlowBreeze toolbar via

"Layout" | "Create a Grid".

There is no fixed value for the grid size since the column width depends

on the row height. The default row height varies between the different

versions of Excel based on the default font. On most systems, Excel 2000

- 2003 use Arial 10pt as the default font, which yields a grid size of 17

pixels. Most Excel 2007 and later systems will use Calibri 11pt as the

default font, which yields a grid size of 20 pixels.

8.4 Create a Symbol Key

A flowchart symbol key lets people viewing your flowchart decipher the

meanings behind the symbols. As the sample image below shows, a

symbol key will show the symbol graphic and symbol name. The symbol
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names can be edited by changing the Name field in the Symbol List grid

on the Settings form. To generate a flowchart symbol key, click Symbol

Key on the FlowBreeze toolbar. You will be prompted to select a location

on the worksheet to place the symbol key. When you click OK the symbol

key is generated with styles applied.

Note: The symbol key is Grouped. If you need to edit the contents of the

symbol key, see how to Work with Grouped Symbols.

8.5 Export as Picture

Important Note: If the worksheet zoom is not set to 100% before

running the Export, shapes may be clipped if you select the "Flowchart

and Sheet" option. If this happens, close the export Picture window, zoom

the sheet to 100%, and try again.
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Image Source options

· Flowchart (shapes only):  The shapes are selected automatically with

this option, and no worksheet content is captured.

· Flowchart and sheet (shapes and/or cell contents): The used range of
the worksheet is selected by default, but you can change it by clicking
the "Select" button which will open a range selection dialog. If you
manually edit the range, you must click refresh to update the preview
image.

Image Destination

· Image type: The following picture formats are supported:

o PNG (the default)

o BMP

oGIF

o JPG (100% quality setting)

o TIF

· File name: Enter the file name to save the image as.

· Folder: the folder where the flowchart is to be saved. The default

location is in the \My Documents\My Flowcharts\ folder.

When you click OK, the image will be saved.

8.6 Export to Web Page

The Export as Web Page tool will take a snap shot of the flowchart on

the current worksheet and save it to an HTML file. The tool can also be

used to take a snap shot of a range of cells, but it will be as an image of

the worksheet, not text.

Select Image
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· Image source: Select either shapes or worksheet content.

· Range: If you selected "Flowchart and sheet", then this field will allow

you to select the image by clicking the "Select ..." button.

· Thumbnail: With this option checked, the web page will contain a

thumbnail linking to the larger image. You can specify the height and

width of the thumbnail below. Changing one dimension will change the

other proportionally.

HTML Properties

· HTML file name: The name of the HTML file and the file extension. You

can select the file extension from the dropdown or type in an unlisted

one.

· Image file name: The name of the image file itself.

· Folder: The folder where the HTML file is to be saved.

· Save flowchart image in a separate folder: One many sites, the images

are stored in a separate folder from the web pages. Checking this allows

to set the image folder path.

· Page title: The <title> element of the HTML page.

· Heading: The <h1> element of the HTML page.

· Image alt text: The alt tag of the <img> element.

· Description: Any text you want to appear in a paragraph below the

flowchart image.

· Open file in browser: If checked the file will be opened after it is created.

FlowBreeze only supports opening standard HTML files locally. If you

enter a different file type, such as php or aspx, the file will be saved but

not be opened.
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8.7 Extract Text

The Extract Text feature will cycle through all the flowchart symbols on

the current and output the text contents to a worksheet location that you

specify. This tool is useful for tabulating process metrics. The process

steps can be diagrammed in a flowchart, then the extraction tool can

output the steps, allowing you to create a table listing any relevant

process metrics such as time, defects, ownership, etc.

Extract Text Dialog

· Text listing: The text from the flowchart symbols, along with a Extract

checkbox to omit an entry. The text can be edited in the listing, if

needed.

· Sort by: Sorting options includes columns then rows, rows then columns,

or alphabetical. The rows can be reordered by drag and drop as well.

· Output range: Select the range for output. It can be on the current

worksheet or another worksheet. Acceptable Excel range formats are

· cell - example: A1.

· worksheet!cell - example; 'sheet1'!A1

· '[workbook]worksheet'!cell - example: '[book1.xlsx]sheet1'!A1

· Link shape content to cells: If checked, each shape's text will be linked

to cell that it was extracted to. For example, if a shape's text is linked to

cell A1, editing cell A1 will change the text in the shape. You can

determine which cell a shape is linked to by clicking on a shape and

looking at the address in the Excel formula bar.

Excluded Shapes

The Extract Text tool excludes the text found in the following shapes:

· Text boxes labels - e.g., the yes/no labels for decision shapes.

· Text in the shapes created by the Flowchart Key tool.
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· Title block text created by the flowchart template generator.

· Outline shapes created by the Group Box tool.

8.8 Find / Replace Text in Shapes

The Find / replace Text tools are located under the Edit Flowchart menu

on the FlowBreeze ribbon tab.

Find / Replace Text: Excel does not have a built-in tool for finding and/or

replacing text within shapes. The FlowBreeze Find / Replace Text in

Shapes tool acts like most other tools to find and replace text, with Find

Next, Replace, and Replace All buttons. The "Current text" and "New text"

fields display the before and after of a replace Operation. Additionally, as

you cycle through finding or replacing text, the corresponding shape is

activated on the worksheet.

Undo Replace: Used to undo the last replace operation. Excel does not

track changes made by add-ins, so this feature allows you to undo the

changes to shape text made by the previous Find / Replace Text action.

8.9 Flowchart Editor

The Flowchart Editor lets you make changes to an existing flowchart. It

loads all the symbols on the sheet and displays them as shown in the

picture below. When you select an  entry from the list, you can change the

text, the symbol type, or the style. The Symbol and Style columns are

clickable drop downs.

Options

· Selected Item group: This area allows you to change the symbol and the
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style for the selected entry.

· Update font: Unchecking this will apply any the other edits but not

change the font within the shapes. 

· Autosize symbols: If checked, any symbol with modified text or font will

be resized to fit the text. Note that if the font is enlarged or the text

length is longer than the original, you may need to move shapes around

in the flowchart afterward to adjust for the new sizing.

· Update line style: If checked, the line style from the available dropdown

list will be applied to all shapes.

· Remove line shadow: The built-in styles in Excel look good on screen,

but often appear fuzzy when printed or exported to image files. This

option remove the shadow from all lines, giving a cleaner look to the

flowchart.

· Include template lines: When updating line styles, if checked this will

force the template swim lane outlines to match the connector line styles.

· Remove borders from solid-fill shapes: There are two groups of styles

available for shapes - Themed and Solid Fill. If this option is checked,

the borders will be removed from all the shapes with solid-fill styles.

8.10 Insert Branch

The Insert Branch tool provides a fast way to add branching or tree

structures to your diagram. This also enables you to quickly create

Organizational Charts (a.k.a., Org. Charts). You can open the Insert

Branch form (Picture 1) from the toolbar or by typing "BR" while

flowcharting.

Base Shape
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If shapes exist on the worksheet, the Base Shape region is populated with

a list of the existing shapes, allowing you to select which shape you want

the flow lines (connectors) routed from. If there are no shapes, then you

can add a shape by entering the text, selecting it's location on the sheet,

and then selecting the shape type and format from the drop down menus.

Branch Type and Options

· Branch Type: Select one of the six types of branch layouts.

· Branch spacing: Determines how much spacing is between each parallel

branch.

· Arrow direction: Determines whether the arrows flow from the base

symbol to the branches (default), or from the branches into the base

symbol.

Add Branch Items

As implied, the Branch text and Branch label fields let you add the text

and branch label for each shape. These fields are optimized for fast entry.

Pressing Enter in the Text field will forward the cursor to the Label field.

Pressing Enter again will add the item to the grid. If both the Text and

Label fields are empty, the form will close and the branch structure will

be created.

Placing a pipe character (| - above the \ on most keyboards) in the Text

field will add a line break to the text when the shape is created. For

example, entering "Tiffany Johnson|VP Operations" will produce the

following branch item:
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Using "|" character to
add line break.  

After the text and label are added to the bottom grid, you can click on the 

Symbol column to change the shape type. Checking the box in the

Dashed Line column will make that line dashed, a common line style for

alternate paths or advisory roles. The branch items are generated left to

right for horizontal branch structures and top to bottom for vertical branch

structures.

Sample Outputs
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Insert branches from existing shape

Insert branches with new base shape
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8.11 Insert Decision Blocks

The Insert Decision Blocks tool allows you to quickly add a series of

decision - side shape pairs to a flowchart, as shown in the Sample Output

picture below.

Decision Block Entry

· Decision text: The text to appear within the decision shape.

· Side shape text: The text to appear in the shape added to the right side

of the decision.

· Add decision block: Clicking this will add the current entries to the list

below.

· Import from worksheet: For convenience, you can create the text for the

entries on a worksheet and import them into the form.

Connector Labels

· The text to appear in the right and bottom branch labels, next to the

outgoing connectors from the decision.

Output Location

· Cell: By default, this will be the cell selected when you open the form.

You can change the location by clicking "Select ...".
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Sample Output

8.12 Insert Group Box

The Group Box tool lets you add a labeled box around a group of shapes.

Note that the Group Box is automatically placed behind all the symbols

and connectors it encompasses. The form allows you to set the text,

formatting, and text alignment within the group box. The "..." button in

the Output Location section lets you select the region where the group

box should be placed. The Style fields let you set the color formatting for

the group box, as well as the corners and line style.
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Sample Group Box

8.13 Print Flowchart Image

Print Flowchart Image is an experimental feature created to resolve

problems with some printers. There is a known bug in Excel where shapes

will print without their text. FlowBreeze uses the native shapes available

in Excel, and because the normal print operations are controlled by Excel
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and are dependant upon the printer driver, there is little that FlowBreeze

can do to correct this problem. The Print Flowchart Image feature works

around this problem by taking a snap shot of the flowchart and printing

the resulting image.

8.14 Quick Styles

The Quick Styles menu has the following options:

· Apply Default Styles: Applies the styles that you have set for connector

lines and each symbol type in the Settings window.

· Reset All Styles to Black and White: Changes all the lines and shape

borders to black, the text to black, and the shape fill color to white.

· Set All Line Weights: Changes the line thickness for all connector lines

and shape borders. The default line weight for Excel 2013 and later is

0.5, and the default line weight for older versions of Excel is 1.5. (Note:

There are known issues with lines rendering improperly when printed or

exported to PDF when line thickness is greater than 1.5. We recommend

line thicknesses of 1.0 or less to minimize the likelihood of these

problems.)

8.15 Re-Align Shapes

If shapes ever become unaligned from the grid, the Re-Align Shapes

tool will nudge each shape to the closest gridline.
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Note: If the flowchart contains a connector that has one end

"connected" to a shape and the other end is not, the connected shape

will not be re-aligned. One quirk of Excel is that moving a shape with a

free floating connector can cause the connector location to be changed

in an unpredictable manner, so these shapes are left as-is.

8.16 Select Shapes Tool

The Select Shapes tool allows you to select multiple symbols filtered by

shape type. You can create and apply filters or manually select or deselect

each shape. When you click OK, all the items checked in the bottom grid

will be selected on the worksheet. The column headers are clickable,

allowing you to sort by column.

· Select all: Checks all the checkboxes in the Select column of the grid.

· Unselect all: Clears all the checkboxes in the Select column of the grid.

· Filter by symbol type: Displays the checklist shown in the second image

below, and as the label implies, allows you to filter the selection by

symbol type.
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Select Shapes tool
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Select Shapes - filter options

8.17 Symbol Styles

FlowBreeze lets you assign styles by individual symbol type. The styles

are based off the built-in styles in Excel 2007 and later, and most of them

can be emulated attractively if the file is opened in older versions of Excel.

Fields

· Selected style: this image shows the currently selected style. To select a

new style, click on it with your mouse.

· Apply To: When it loads, the style for the currently selected symbol will be

highlighted. When you change a style, you have three options:
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o Apply to current symbol: Applies the style only to the symbol that is

selected in the calling form.

o Apply to all symbols: Replaces the style for all the symbols in the

calling form.

o Apply to symbols that use the previous style: Applies the style to all

the symbols that have the same style as the one currently selected in

the Symbol List grid of the main Settings window. For example, if the

currently selected symbol has a white fill color and you change it to

orange, this setting would replace the style for all the symbols having

a white fill. But any symbol with, say, blue or red fill would not be

affected.

Note: The "Apply to" options may not be visible. This window is

launched from several other forms in FlowBreeze, and the "Apply to"

options may not be applicable. 

    

8.18 View Gridlines

The View Gridlines feature will show or hide the Excel gridlines. Gridlines

can be helpful when laying out a flowchart, but when it comes time to 

save it as a picture, hiding the gridlines makes it look nicer. Below are

screenshots with the gridlines toggled on and off.
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9 Connectors

9.1 Add Connectors

The Add Connectors dialog will let you add one or more flow line

connectors between shapes. The settings are based on the configuration

set in the Settings window. Opening the Add Connector tool can be done

in two ways:

· Click Add Connector on the FlowBreeze toolbar.

· Type "FL" during a flowcharting session.

Usage

Select the respective texts for the "From Shape" and the "To Shape" that

you want to route the flow line connector between, then click the "Add

Connector" button. Alternately, you can click on the first shape, hold the

SHIFT key and click on the second shape, then click the Refresh button -

the two shapes will be selected in the corresponding lists.

Settings

Most of the settings are self-explanatory (hopefully), but there are two

worth commenting on:

· Auto-detect (connection sides): If selected, FlowBreeze will try to
determine the best route for the flow line connector. However, there
may be occasions that the routing isn't optimal. If this happens, click on
the connector, then drag one endpoint to the new connections side. For
elbow and curved connectors, a yellow diamond "adjustment handle" will
appear when the line is selected. The handle can be clicked and dragged
to adjust the routing as well.

· Straight, elbow, and curved line styles: If the connection is a straight
line between the shapes, FlowBreeze will force the connector type to
straight even if you selected elbow or curved. 

Adding Multiple Connectors
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To add multiple connectors, just change the "From shape" and "To shape" selections and

click "Add connector" again.

Notes

· Press x in the upper right of the panel to close it.

· Press « in the upper right to collapse the panel to the left edge of Excel.

· Not shown in picture below: you can sort the listings alphabetically, by

column, or by row.

9.2 Split Connector into Nodes

The Split Connector tool will replace a flow line with two labeled nodes,

which indicate a jump from one part of the diagram to another. The

before and after picture below an example usage of the tool.

Connector routing - before Split Connector
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Connector routing - after Split Connector

Dialog Fields

· From shape - Node placement side: The "From shape" box shows the

text from the first shape, and the adjoining "Node placement side" lets

you select the side that the outgoing labeled node will be placed (relative

to the shape).

· To shape - Node placement side: The "To shape" box shows the text

from the second shape, and the adjoining "Node placement side" lets

you select the side that the incoming labeled node will be placed

(relative to the shape).

· Connector node type: The circle "On Page Connector" nodes are typically

used for jumps between process steps on the same page, and the 5-

sided "Off-Page connector" nodes are typically used to indicate a jump

from one page to another.

· Node label: The text that will be placed in the node. The text is

automatically assigned when you selected a connector node type, but it

can be changed as needed.
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9.3 Straighten Connectors

Elbow connectors can appear jagged if they connect two aligned shapes,

as shown in the first image below. To fix this problem, click Layout >

Straighten Connectors from the FlowBreeze toolbar.

 You can also manually change the appearance by right-clicking the line

and selecting Connector Types > Straight Connector from the context

menu, as shown below.

The line will now render without the slight jog in the center.
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9.4 Crossover

Accessible from the Add Connectors, this tool inserts a crossover "bump"

in a connector line to distinguish between intersecting lines. To use this

tool, you must first select the connector before clicking the button. 

Important Note

The Crossover tool was designed to overcome a shortcoming in the native

Excel lines, which do not have a built-in crossover functionality. However,

the Crossover tool should be used mainly for short, straight lines that

intersect another line. If used with long lines or elbow connectors, the

routing to and from the crossover bump may take irregular form. In most

cases, the Split Connector tool should be used instead for cleaner routing

and better readability.

Form Inputs

· Crossover cell: FlowBreeze will try to guess where the bump should go,

but you may need to change the location to match the location of the

intersecting line.

· Automatically adjust alignment: If checked, FlowBreeze will try to align

the crossover.

· Crossover orientation: Indicates whether the crossover should be
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horizontally or vertically rotated.

9.5 Work with Flow Lines (Connectors)

Terminology

In flowcharting, an arrow from one process step to the next is often called

a "Connector", a "Flow Line", or simply an "Arrow". As the names indicate,

they show the direction of process flow. This help file uses the terms

"Connector" and "Flow Line" interchangeably. In Excel, there are Arrows

that do not stay attached to shapes, as explained below. Also, "Connector"

means two things in Excel - a line that stays connected to a shape and

also as the term used to describe symbols that show a jump from one part

of the flowchart to another. These two symbols are called On-Page

Connectors and Off-Page Connectors, labeled "A" and "1", respectively, in

Picture 1 below.

  

Picture 1 - On and Off-page Connectors

(Do not confuse these types of "Connectors" with flow line "Connectors")

Flow line connectors vs. standard arrows and lines

Because of the possible confusion caused by using the word "Connector"

for both connecting arrows and two symbol types, the FlowBreeze

documentation will try to stick to using the term "flow line". That said,

there is one instance when using the term "Connector" makes sense. That

is to differentiate between an arrow that "connects" to a shape and a

standard line or arrow that does not. (N.B.: starting with 2007, Excel no

longer has arrows that don't connect to shapes.)  A flow line "connector"
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will attach to a shape. When the shape is moved, the  connector will stay

attached to the shape whereas a standard line or arrow will not. To tell

whether a flow line is connected to a shape, click on it and you should see

a red dot at the connection points, as shown in the image below.

Picture 2 - Connected Flow Line

If one or both of the flow line end points has a green dot when selected

(shown below), then it is not connected to the shape. If Symbol 2 were

moved, the flow line will not be moved with it. To re-connect a flow line

like this, click on the green dot with your mouse and drag it to a

connection point on the shape.

Picture 3 - Unconnected Flow Line

Each symbol type has preset connection points. When you position the

mouse over a symbol, the cursor will change from an arrow (or cross hair 

 if you are adding a new flow line manually) to a bomb site  and the

connection points will show as blue dots on the symbol border as shown in

Picture 4 below.

Picture 4 - Connection Points

Flow line connector types 

There are three types of flow lines that you can create with FlowBreeze -

straight, elbow, and curved, as shown below. The elbow connector is the

default in FlowBreeze because it renders as a straight line when the
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symbols are aligned.

Picture 5 - Flow Line Styles

Changing flow line connector types

You can change the type of flow line by right-clicking on it and selecting

the new type as shown below in Picture 6.

Picture 6 - Change Flow Line Type
(This menu is slightly different in Excel 2007+)

Rerouting Flow Lines

To change the routing of a flow line, you can click on an end point and

drag it to a new connection point (while holding the left mouse button

down). Also, you can use Excel's built-in "Reroute Connectors" function,

shown above in Picture 6. This function will pick the shortest route

between two points, so if there are any shapes between the two target
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shapes, there is a good chance that the flow line will be routed behind one

of them. In such a case, it's easier to manually drag the end point to the

new connection point.

You may find a layout where the flow lines don't line up as you would like

them to. For example, in picture 7 below, the layout would look better if

the flow line from Symbol 1 to Symbol 2 was in vertical alignment with the

flow line from Symbol 3 to Symbol 2. To adjust the routing, first click on

the flow line. A yellow diamond "handle" will appear. You can click on the

yellow handle and drag the routing to a new position (as always, while

holding the left mouse button down). The new routing will show as a

dashed line while you drag the adjustment handle.

Picture 7 - Flow Line Adjustment Handle

See Also: How to Snap Objects for an example of routing one flow line

to connect to another flow line.

Snapping A Connector to Another Connector

A common goal of FlowBreeze users is to route a connector line so that

the end point connects to another connector arrow. The Excel lines do not

have the capability to connect to other lines. This section shows two other

options.

Option 1 - Use Snap to Grid
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It's natural to assume that "Snap to Shapes" will allow you to snap one

connector line to another, however, the "Snap to Shapes" setting will snap

lines to all shapes except other lines. The best alternative is to use "Snap

to Grid". (FlowBreeze uses the built-in "Snap to Shapes" and "Snap to

Grid" Excel tools, but it doesn't have control of their behavior.)

1.Toggle on "Snap to Grid".

2.Drag the step 1 - step 3 connector end point to the desired position.

3.Right-click on the connector and select Format Shape from the context

menu.

4.Click the Line Style option in the lane pane of the Format Shape dialog.

5.Using the End Type drop down, change end point from an arrow to a

straight line segment.

Snap connector to grid

Option 2 - Add a Connector Node

1.Click Add Shapes to open the Add Shapes dialog.

2.Add a circular Connector Node shape.

3.Reroute existing lines to feed into connector node.

4.Add new connector line from node to step 3.

5.Resize connector node as needed for alignment.
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Connector snapped to node shape

Adding a Jog or Jump to a Flow Line

Unfortunately you can't. Some drawing tools allow you to add a jog to a

line to indicate a crossover, as shown in Picture 7. 

Picture 7 -
Line Jog  

Excel doesn't have this capability, and therefore neither does FlowBreeze.

However, there are workarounds. One method is to use the Split

Connector tool to replace the flow line with two connector nodes. Another

method is shown below in the picture below. If you have a confusing

routing (as shown on left), you can change one of the line types to Curved

to make the routings clearer. See the Changing Flow Line Types section

above for how to do this.
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Line Jog Workaround
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10 Editing Tips

Here are some tips to make editing as fast as possible for you:

1. Turn on Snap to Grid. Click Snap to Grid on the FlowBreeze ribbon.

2. You can move one or more shapes by selecting them and using the

keyboard arrow keys. You can only move the shapes in the viewable

area, so you may need to scroll as you move them.

3. You can use the Tab key to move the selection from shape to shape.

4. You can select multiple shapes several ways:

· Holding the Shift key down while clicking on them.

· Using Select Objects (white arrow) from the FlowBreeze toolbar. Left-

click and drag around shapes to select them.

· Using Shape Selection Tool from the FlowBreeze toolbar.

5. Moving a shape will cause the connectors to reroute automatically. 

· If the connector doesn't reroute, then it wasn't connected. To connect

it, click the line's end point and drag it to the shape.

· If the routing isn't optimal, right-click on the connector and select

"Reroute Connectors" from the context menu. 

6. Deleting empty cells (or entire rows) between shapes will condense the

drawing by shifting all the shapes below the row(s) upward. The same

applies to deleting columns. Inserting rows and or columns will expand

the drawing. See the in depth sections Deleting Symbols and Inserting

Symbols for more details.

7. You can copy an existing shape by holding the Ctrl key down then left-

clicking and dragging it. Note: The Ctrl key needs to be pressed before

the mouse is over the shape.

8. You can copy and paste the format of one shape to another by clicking

the first shape, then clicking the  Format Painter button in the

toolbar, then clicking the second shape.



FlowBreeze 4 Help File96

© 2017 BreezeTree Software

10.1 Deleting Symbols

To delete a symbol, you need to select it and press the Delete button on

your keyboard. Tip: Click on the border of a symbol to select it. If you

click on the text portion of the symbol, you will be in text editing mode

instead. After you delete the symbol, you will most likely need to shift the

remaining symbols. The following is a step-by-step guide on how to adjust

the layout, given a flowchart that looks like Picture 1.

Picture 1

If you want to remove Step 2, it will leave a gap, as shown in Picture 2.
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Picture 2

To move the other symbols, you can select multiple shapes and drag to

adjust their location. However, if the flowchart is large it can be a time

consuming task to. The faster way is to delete cells or rows / columns.

Excel moves shapes when cells are inserted, deleted, or resized. If you

select a range of cells, as shown in Picture 3, you can right-click on the

cells and select "Delete..." from the context menu, and the Delete Cells

dialog will open as shown in Picture 4.

You must select a range of cells as wide or wider than the symbols you

want moved. For Decision symbols, the range width selected should

encompass the branch labels as well as the Decision symbol itself. In the

example shown in Picture 3, the range of cells selected is as wide as both

the Dept 2 and Dept 3 swim lanes to ensure that all the symbols are

shifted up. If you want everything shifted up, you could also delete entire

rows.
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Picture 3  

Picture 4

The result can be seen in Picture 5. The connector to Step 3 is not

connected. Step 3 was moved into position to be connected to Step 1, but

the connection still needs to be closed manually.
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Picture 5

Note: When a connector is "connected" to a symbol, there should be a red dot on the end of it

when the connector is selected. If it is unconnected, the dot will be clear.

10.2 Inserting Symbols

After you've completed your flowchart, sometimes there's the need to go

back and edit the flowchart, adding additional symbols. There are two

ways to do this - using FlowBreeze's text-to-flowchart automation or via

the toolbar.

Creating Space for the New Symbol

Inserting new flowchart symbols is essentially the same process as 

deleting flowchart symbols - just in reverse. As with a Delete operation,

we select the range of cells to perform the insert on. Again, the range is

selected so that the cell shifting effects the other flowchart symbols in the

desired way. In the example in Picture 1, we want to shift the symbols in

both the Dept 2 and Dept 3 swim lanes, so we select a range wide enough

to encompass the symbols in both lanes. The height of the range selection
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allows for a new symbol that is the same height as the Step 3 symbol, but

if you want to add a symbol that requires more vertical space, you should

select a taller range.

Picture 1

After the cell insert, the symbols have shifted along with the cells and a

space has been opened up to place the new flowchart symbol, as shown in

Picture 2.
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Picture 2

Inserting the Symbol

Method 1 - via Add Symbols and Add Connectors dialogs (Recommended)

See the Add Symbols and Add Connector sections for details on using

these tools.

Method 2 - Text-To-Flowchart

1.Click the "Start" button on the FlowBreeze ribbon tab.

2.Type the text for the symbol in the location you want the symbol to

appear, and hit Enter.

3.Most likely, you will be prompted to add a flow line from a neighboring

symbol. If applicable, select the symbol to route a flow line from and

click OK.

4.If needed, type "FL" in a nearby cell to bring up the Add Connector

dialog. Select the new symbol and a symbol to route another flow line

to, then click OK.

5.Click the Stop Flowcharting button on the FlowBreeze toolbar.
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Method 3 - via FlowBreeze Ribbon

1.Click the Insert tab on the main Excel ribbon.

2.Click on the desired symbol from the Shapes drop down gallery.

3.Click the sheet to place the symbol.

4.Add text as desired.

5.Change the styling to match other symbols, as needed.

Picture 3 shows a simple example of the a new flowchart symbol that has

been added. If you used Method 1 above, then the flow line connectors

can be added automatically. If you used Methods 2 or 3, then you will

need to insert them manually via the toolbar.

Picture 3

Related

Change Symbol Styles



Editing Tips 103

© 2017 BreezeTree Software

10.3 Moving Symbols

Although FlowBreeze will automatically place the flowchart symbols on the

drawing sheet, some functions such as the Flowchart Wizard may require

manual adjustments after the fact. Symbols can be moved using the

mouse or with the arrow keys on your keyboard.

Steps

1.Turn on Snap to Grid.

2.Select one or more symbols.

3.Move the symbols using the arrow keys on your keyboard (left, right,

up, and down.)

· To nudge symbols in any direction, hold down the Ctrl key while

pressing one of the arrow keys.

· Alternately, you can drag the symbols to the new location with your

mouse.

4.Reroute any flow line connectors as needed.

Related Topics

· How to Select Symbols.

· How to use the Symbol Selection Tool.

· How to Work with Flow Lines.

10.4 Resizing Symbols

Resizing of shapes is often needed if the text is too long to fit within a

given size. FlowBreeze will auto-size shapes when they are created, but

there are times when text needs to be edited. If the new text is longer,
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this can lead to an undersized flowchart shape. Also, resizing is often a

good idea to keep all the shapes in a row or column a uniform size. Not

only does this look nicer, but it improves clarity and readability as well.

Steps

1.Click on the flowchart symbol with your mouse to select it.

2.The symbol's sides and corners will display little circles called "handles".

3.Position your mouse over one of the handles until the mouse cursor

changes to little double arrows.

4.Click on the handle and, while holding the left mouse button down, drag

the edge of the symbol until you get the size you want.

Tips

· Turn on Snap to Grid to ensure the symbols remain aligned to the grid.

· While you are re-sizing a symbol, the outline of the new size is shown in

dashed lines as shown below.

· Dragging a corner handle allows you to resize the height and width

simultaneously.

· Sizing symbol heights and widths to an even number grid units ensures

that flow lines run straight. 

Symbol resizing
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10.5 Rotating Symbols

Shapes can be rotated in Excel, but there is one significant difference

between Excel versions. In Excel 2007 and later, the text will rotate along

with the symbol, but if the file is viewed in an older version of Excel (i.e.,

Excel 2003), the symbol will appear rotated, but the text will not.

Rotate a symbol via size dialog

This method allows for more precise control of the angle setting. Also, you

can select multiple shapes and rotate them all at once.

· Right-click on the shape to bring up the context menu.

· Click "Size and Properties" to open the Size settings.

· Click the "Size" tab.

· Change "Rotation" to the desired angle. Rotation angles are clockwise.

Rotate a symbol directly on the worksheet

Follow these steps to rotate a symbol directly on the worksheet:

· Select the symbol using your mouse.

· A green dot will appear above the symbol, as shown in the picture

below.

· Position your mouse over the green dot until the mouse pointer turns

into a circular arrow.

· Click down on the green dot and rotate the symbol to the angle desired.

· A dashed outline of the rotation will be displayed as you adjust the

angle.

· Release the left mouse button when the symbol is at the desired angle.
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Excel 2003
Excel 2007

(text rotated)

10.6 Snapping Shapes

"Snap" is a term that means shapes are aligned, moved, or re-sized in

uniform intervals or positions. In Excel, there are two types of snapping

available: Snap to Grid and Snap to Shape. FlowBreeze activates both

types of snap automatically a flowcharting session is started. But if you

ever close a workbook and re-open it, you will be to turn them back on

manually if you want to edit the flowchart.

Snap to Grid

Snaps the symbols to the nearest worksheet cell gridline when positioning

or sizing symbols. The Snap to Grid button is located on the main

FlowBreeze ribbon tab.

Snap to Shape

Snaps the symbols to the nearest shape. It is activated by clicking Grid >

Snap to Shape. A common usage for this is to route flow lines up to other

flow lines, as show below.
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10.7 Selecting Shapes

There are several different methods used to select symbols. Methods 1

and 2 are god when selecting a few nearby shapes. Methods 3 and 4 are

more suitable for selecting multiple shapes. 

Method 1 - Mouse click

If you want to select a single symbol, click on it with your mouse.

However, this can be a little tricky if the symbol contains text or if the

border is not visible. If the symbol contains text, you need to click on the

border of the symbol, otherwise, clicking in the center will select the text

frame inside the symbol. If you already have one or more symbols

selected, you can select additional symbols by holding the Shift key down

while you click on other symbols. If the symbol has no border (such as a

text box used for a branch label), then you can either click around the

region until it's finally selected or use Method 2 (recommended).

Method 2 - The Select Objects cursor

This cursor can be accessed by clicking Select Objects from the

FlowBreeze toolbar. This will change the mouse pointer to a thick white

arrow. You can then select symbols by clicking on the sheet with the left

mouse button and dragging around one or more symbols that you wish to

select. The symbols must be completely enclosing within the dashed line

boundaries, as show in the picture below. If you release the left mouse

button with only half of the symbol encompassed, it will not be selected.

Important: If you use this tool, you cannot select worksheet cells until
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you click Select Shapes again or double-click on a worksheet cell to

toggle it off.

Method 3 - The Shape Selection tool

The Selection Tool is a special FlowBreeze window that allows you to filter

the selection by shape type. More details on how to use it can be found

by clicking here.

Method 4 - The Select Shapes menu tools

· Select All: Selects all the flowchart shapes, connectors, and labels on the

current worksheet.

· Flowchart Symbols: Selects only the flowchart shapes, connectors, and

labels on the current worksheet.

· Connectors: Selects only the connectors on the current worksheet.

· Labels: Selects only the flowchart labels (borderless text boxes) on the

current worksheet.
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11 How Do I ...?

11.1 Add an Assist Line to a Swim Lane Diagram

An assist line in a swim lane diagram shows that a resource is indirectly

responsible for a process step. For example, the following picture shows

that Operations is directly responsible for the "Create action plan" step

and that Engineering will assist with the step.

Steps to add an Assist Line:

1.Add a line from the target flowchart shape to the swim lane of the

assisting resource by clicking the "Shapes" drop down and selecting a

line from the gallery of symbols. Hold the left mouse button down to

draw the line.

2.Right-click on the line and select "Format Autoshape" from the popup

menu.

3.Select "Line Style" from the left menu.

4.Change the "Begin style" to straight.

5.Change the "End style" to oval and the "End size" to the largest

available, then click "OK" to apply.

6.(Optional) Use the Format Painter tool to copy the style from an existing

line to the assist line. The Format Painter button is located on the

FlowBreeze tab.
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11.2 Call FlowBreeze from VBA

Many FlowBreeze features can be called from VBA. Below is VBA sample

that shows how to get a reference to the FlowBreeze add-in and make a

simple function call.

Sample VBA
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Sub RunFlowBreezeOperation()

    Dim addin As COMAddIn
    Dim flowbreeze As Object

    Set addin = GetFlowBreezeAddin()
    If Not addin Is Nothing Then
        Set flowbreeze = addin.Object
        flowbreeze.CreateWorksheetGrid
    End If

End Sub

Function GetFlowBreezeAddin() As Object

    Dim addin As COMAddIn

    For Each addin In Application.COMAddIns
        If Left$(addin.Description, 10) = "FlowBreeze" Then
            Set GetFlowBreezeAddin = addin
            Exit Function
        End If
    Next
    Set GetFlowBreezeAddin = Nothing

End Function

FlowBreeze Function List (ordered by ribbon

appearance)

Note: In FlowBreeze version 4, the function names no longer have to be

prefixed with "FB_" (existing code that uses the FB_ prefix will still run).

Flowcharting Group

· StartFlowcharting

· StopFlowcharting(promptForEndTerminator as Boolean)

· OpenSettingsForm
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· RunFlowchartWizard

· WizardApplyParsingSyntax

· WizardTransposeColumns

· CreateTemplate

· CreateVSMTemplate

· LoadTemplate

· LoadTemplateInNewWorkbook

· ExportPicture

· ExportHTML

· PrintImage

Insert Group

· ShowAddSymbolsTaskPane

· ShowConnectorsTaskPane

· ShowVSMTaskPane

· InsertBranch

· InsertGroupBox

· InsertDecisionBlocks

Edit Group

· EditFlowchart

· ApplyDefaultStyles

· ApplyBlackAndWhiteStyles

· SetLineWidths(lineWidth as Single)

Layout Group

· ReAlignShapes

· CreateWorksheetGrid

· ClearShading
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· SnapAll

Select Group

· GroupAllShapes

· UngroupAllShapes

· LoadShapeSelectionTool

· SelectFlowchartConnectors

· SelectFlowchartLabels

· SelectFlowchartSymbols

Connectors Group

· StraightenFlowchartConnectors

· SplitFlowchartConnectors

Tools Group

· CreateSymbolKey

· ExtractTextFromShapes

11.3 Change Symbol Styles

Method 1 - Flowchart Editor

See the Flowchart Editor section for more details.

Method 2 - Apply Default Styles

Use the Apply Styles tool if you want to apply the default style as listed in

the settings dialog.



FlowBreeze 4 Help File114

© 2017 BreezeTree Software

Method 3 - Format Painter

If a symbol (or flow line) exists on the worksheet having the style you

want, then:

1.Click on the border of symbol whose style you want to copy.

2.Click the Format Painter button .

3.Click on the target symbol, and the style will be applied.

Method 4 - Manual Formatting

Note: FlowBreeze cannot support custom formatting when creating

new shapes or using the Flowchart Editor.

1.Click on the symbol to select it.

2.Click on the tab labeled "Format" that appears on the ribbon.

3.In the "Shape Styles" section, there is a clickable gallery of fill styles.

If you prefer a custom fill color, try this:

1.Right-click on the symbol and select "Format Shape".

2.On the Format Shape dialog, select "Fill" from the left column.

3.Click the "Color" dropdown to select a new fill color.

4.Click "Close".

Note: If you click on the center of a symbol, you will usually select the

text instead of the symbol itself, which is why clicking the border is

recommended.
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11.4 Change a Symbol Type

Flowchart Editor

The automated way to change a symbol type in FlowBreeze is to use the 

Flowchart Editor.  Excel has a built-in Change Autoshape tool, however,

using this tool will cause all the connector lines to become disconnected

from the shape, and you will need to reconnect them by dragging the end

points to the symbol's sides. The Flowchart Editor corrects this problem.

Manual editing

To manually change the shape type, follow the steps below.

· Click the symbol's border to select it.

· Excel should automatically display and select a Format tab.

· Click "Edit Shape".

· Click Change Autoshape from the drop down, and select the new symbol

type from the gallery.

· Any connectors routed to the symbol will now be disconnected. Click the

connector line and drag the end point to the side of the symbol to

reconnect it.

11.5 Edit Symbol Text

To edit the symbol text, you need to select the text, modify it as needed,

then handle any resizing and flowchart re-layout issues.

Selecting Text

To select the text, click on the interior of the symbol. You can select
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portions of the text using the mouse or the Shift and Arrow keys on the

keyboard.

If you have the Select Objects tool  enabled, you cannot select the text

directly. Clicking anywhere on the symbol will select the symbol itself - not

the text. You can either right-click on the symbol and select "Edit Text"

from the popup menu, or you toggle the Select Objects tool off by clicking

it again on the toolbar.

Modifying Text

You can edit the text within the symbol just as you would with any text

editor. Portions of the text can be selected and formatted with the Excel

formatting controls available on the Home. This includes standard

formatting functions like bold, italic, underline, and color formatting.

Note: Hitting the Enter key will add a line break within the symbol's text.

When you are done editing the text, select anywhere else on the

worksheet to exit editing mode.

Resizing and Re-Layout

After you modify the text, the length of the text may exceed the size of

the symbol. Check the Resize Symbols and Move Symbols sections of the

help file if needed.

11.6 Export a Flowchart to Word or PowerPoint

Options
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This page covers three ways to get your flowchart from Excel to another

document:

· Embed an editable Excel file in the other document.

· Copy and paste into another document.

· Export the flowchart as an image, and then insert the file image into the

document.

Option 1 - Embed the Flowchart

When you embed an Excel file in Word or PowerPoint it appears as a

resizable image, but you can double-click to edit it. To embed the

flowchart, follow these steps:

1.Save and close the Excel file containing the flowchart. The sheet

containing the flowchart needs to be the active sheet, and the flowchart

should be scrolled into view.

2.In Word or PowerPoint:

· Select the location for the flowchart to be placed.

· On the Insert tab, click Object. (Use the Insert menu in Word 2003

and older versions.)

· Select "Create from file" and use browse button to locate the Excel

file.

· When you click OK, the Excel file will be embedded in the document.

3.Click and drag the edge of the embedded object frame to resize as

needed.

Should You "Link to File"?

Recommended answer: No.
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If you link to file:

· You cannot scroll or resize the visible worksheet range. This is a

significant problem if you need to adjust the viewable portion of the

embedded flowchart.

· Despite the linking implication, changes to the original Excel file are not

automatically updated in the Word document. You must right-click on

the embedded object and select Update Link from the pop-up menu to

force a refresh.

Adjusting the View

In the flowchart view needs to be adjusted:

· Double-click the embedded Excel file to activate it.

· Scroll the flowchart into view as desired.

· While still active, click and drag the edge border to resize the visible

worksheet range.

Editing Embedded Flowcharts

If you double-click the embedded object, you have full access to all of

Excel's tools - including the FlowBreeze features.

Option 2 - Copy and Paste into an Office Document

1.Click Select Shapes >  Select All from the FlowBreeze toolbar.

2.Use the normal Copy function. (In Excel 2010 and later, do not use the

Copy Picture tool. It will not give us the Paste Special option we need in
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the next step.)

3.In the target file, click Paste Special and select the "Picture (Enhanced

Metafile)" option. Metafiles are a special type of image that render the

text clearly when resized.

Option 3 - Export Flowchart as Image

The last option is to use the Export as Picture tool, and then to insert the

image file into the target document. But if you need to resize the image in

the target document, Option 2 provides a better image format for

rendering legible text.

11.7 Import and Export Settings

To backup your settings or to standardize settings between users, you can

export settings from one computer and import them into another. To open

the import / export tool, click Help > Import / Export Settings. Select

whether to import or export then click next. You will be prompted for the

file name.

If the Template Generator has a logo assigned, it will also be exported and

should be copied to the target computer. When importing the settings, the

import tool will look for the logo file in the same folder that the settings

file is located.
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11.8 Insert a Hyperlink

Flowchart symbols can hyperlink to other documents, web sites, email

addresses, to other sheets in the same workbook, or other locations

within the same flowchart.

How To Add a Hyperlink

To insert a hyperlink, right-click on the symbol and select Hyperlink from

the popup menu as shown in Picture 1, below.

Right-Click Popup Menu

This will open the Insert Hyperlink window, as shown in Picture 2, below.

It allows you to browse to the document and link to it. If the document

contains internal bookmarks, you can link directly to the bookmark (see

the Word help documentation for information on how to add bookmarks to

your documents). Clicking the "ScreenTip..." button lets you enter text

that will display when the mouse is positioned over the symbol containing
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the hyperlink.

If you choose "Place in This Document" from the "Link to:" column, you

can select a worksheet and cell reference within the current Excel file. You

can also link to a Defined Name range. You cannot link directly to another

symbol, so the best alternative is to link to a cell beside the target

symbol.

Insert Hyperlink Window

Removing Hyperlinks

If you wish to remove a hyperlink, right-click on the symbol and a Remove

Hyperlink option will be available on the popup menu.

Selecting Shapes with Hyperlinks

Clicking on a shape with a hyperlink will follow the link, so in order to

select it, you will need to click on it with your right mouse button.
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Formatting Links

Linked shapes do not have the characteristic underlined text that is

common on the internet. To signal that the shape is linked, you can select

the shape (or text within the shape) and use the Underline formatting

available on the Excel Home tab.

Note on Network Drives

If you link to a file on a mapped network drive (e.g., G:, M:, T:), you need

to be careful of special situations. If you save the file to your system, then

later move it to a network drive, the hyperlink may break since other

users might not have the network drive mapped to the same letter. It is

best to use UNC paths when possible, which look like \

\servername\directory\...

11.9 Insert a Label

FlowBreeze allows two ways to insert labels and text boxes on the

drawing. Text boxes are useful for adding comments to flow lines to

indicate the logic behind the flow direction. The most common occurrence

is for branches coming out of Decision symbols. There are several reasons

why labels should be placed into TextBoxes instead of directly on the

worksheet:

· Labels in TextBoxes can be copied to Word or PowerPoint

· Labels in TextBoxes can be selected and moved around the drawing like

other shapes.

· The automatic formatting tools will apply styles to labels in TextBoxes.
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Method 1 - Prefix w/ Label

If you are in flowcharting mode, typing "LBL" followed by the prefix

delimiter and the label contents will add the label. That sounds more

complex than it is, so here's an example:

lbl:Option 1

Will add a TextBox containing the phrase "Option 1" at the cell location

where you entered it. The "lbl" portion is not case sensitive, so it can be

"lbl" or "LBL". The ":" is the default prefix delimiter. If you have

FlowBreeze Standard Edition, you may change the prefix delimiter and the

label font on the General tab of the Settings window.

Method 2 - Prefix Only

Like the previous method, you can type "LBL" (without the quotes / not

case sensitive) to add a label. Because no text appears after "LBL", it will

prompt for the label text with a simple Add Label dialog. Just type the

label text and hit the Enter key (or click OK.) FlowBreeze will add the label

to the current cell.

Method 3 - via Add Symbols dialog

The standard Excel text box can be added by using the Add Symbols

dialog. The text box item is located in the Flowchart shapes group.

11.10 Using Keywords and Prefixes

Keywords and Prefixes are central to the power of FlowBreeze. In a

nutshell, these are the two ways that FlowBreeze automatically generates
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flowchart symbols and other shapes from your text. Here's how each

works.

Picture 1 - Symbol List
(from the Settings window)

Keywords

· Definition: A "keyword" is a word that you assign to a symbol. Whenever

you use a keyword in an entry, FlowBreeze will spot the keyword and

generate the associated symbol.

· Usage: You define keywords for a symbol in the Settings window, as

shown in Picture 1 above.

· Example: Picture 1 shows that the word "REPORT" is set as a keyword

for the Document symbol. If you are in flowcharting mode and type
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"Print TPS report", FlowBreeze will detect the keyword

"report" (keywords are not case sensitive) and generate a Document

symbol containing the text entered.

· Exact match: Place an equal sign (=) in front of a keyword to associate

it to a symbol only when the flowchart text consists solely of the

keyword.

· Priority: Again referring Picture 1, there are two buttons with up / down

arrows next to the active symbols list. These let you set the order in

which Keywords are evaluated. If an entry contains keywords associated

with two different shapes, the shape with the higher priority on the list

will be generated.

· Default Symbol: If an entry contains no keywords (or prefixes), then a

process symbol (rectangle) is generated by default.

Note: Keywords must be whole words. Therefore the plural form of a

keyword would not be recognized unless it was explicitly added to the

keyword list.

Prefixes

· Definition: A "prefix" is abbreviation that you assign to a symbol.

Whenever you put a prefix at the beginning of an entry, followed by use

a prefix delimiter, FlowBreeze will spot the prefix and generate the

associated symbol.

· Usage: You define the prefix for a symbol in the Settings window, as

shown in Picture 1 above.

· Example: Picture 1 shows that "IO" is the prefix for the Data symbol.

You can force a Data symbol to be generated by using the prefix "io"

even if none of the symbol's text will contain a keyword. So if you type

"io:get buffer file", FlowBreeze will detect the prefix and generate a data
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symbol containing the words "Get buffer file". Prefixes are not case

sensitive.

· Prefix Delimiter: Referring to the example above, the colon (":") in "io:

get buffer file" is the prefix delimiter. In order for FlowBreeze to

recognize that a prefix is being used, the prefix must be separated from

the entry with a delimiter. You can set a different delimiter on the 

General tab of the Settings window.

· Reserved Prefixes: No two symbols can have the same prefix, and there

are several prefixes reserved by FlowBreeze for special use. These

include: BR, FL, GFX, LBL, PIC, SHP, and TB.

Note: You can also use prefixes to create empty symbols with no text

in them.

Evaluation Priority

If an entry contains both a prefix and a keyword, the prefix will have

precedence over the keyword. The evaluation priority to determine a

shape type is as follows:

1. Prefixes

2. Special rules for decisions and connector nodes.

3. Keywords

11.11 Work with Grouped Symbols

Excel allows you to Group shapes together so that they can be treated as

a single shape. This lets you select the grouped items as one item and
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move, copy, or delete it more easily. It also protects the layout of a set of

shapes, since it fixes the grouped items in place.

Group menu functions

· Group: Allows you manipulate a set of shapes as a single shape. To

group a set of symbols, first you need to select the symbols, then apply

the Group function.

· Ungroup: Ungroups the shapes so they can be individually moved,

edited, or deleted.

· Regroup: If a shape had previously been in a group that was later

ungrouped, you can Regroup the entire set of shapes by clicking on a

single one and applying the Regroup function.

· Group All Shapes: Groups all the shapes on the sheet in a single click.

· Ungroup All Shapes: Ungroups all the shapes on the sheet in a single

click.

Group, Ungroup, and Regroup are built-in Excel features. Group All

Shapes and Ungroup All Shapes are features added by FlowBreeze.
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12 Support

12.1 FlowBreeze Support

Contact information

BreezeTree's support can be contacted via email at support@breezetree.

com.

When contacting support ...

If you need to contact support to report a problem, the following

information is helpful when contacting support.

· Which FlowBreeze feature you were trying to use when the error

occurred.

· If possible, the steps needed to re-produce the problem.

· If possible, a copy of the Excel file you were working on. (All material is

treated as confidential.) 

· The version of Excel.

· The version of Windows you are running.

· The version of FlowBreeze that you are running. From the FlowBreeze

toolbar, click Help > About to see the version number.

· The contents of the FlowBreeze event log.

12.2 Log Files

FlowBreeze creates a log for errors and other events. If contacting

support to report a problem, it is often helpful to view the following log

files:

· \Documents\FlowBreezeEvents.log
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· \Documents\Add-in Express\adxloader.log

· \Documents\Add-in Express\adxregistrator.log

The log file is also available by clicking Help > View Event Log from the

FlowBreeze ribbon tab.

12.3 Troubleshooting

Installation Error

If you receive an error message during installation, the following items

cover nearly all the cases reported to our support:

1.The majority of installation problems are solved by running the Admin-

Level Setup, which is available on the BreezeTree Downloads page. As

the name implies, it does require administrative privileges on your

system. Depending on your organization's policies, you may need to

have your IT department install it for you.

2.FlowBreeze runs on Windows only. (Sorry - we are not able to provide a

Mac compatible version.)

3.If you have previously installed FlowBreeze, you must uninstall the

older version before installing the updated one.

FlowBreeze Ribbon (Toolbar)

If the FlowBreeze ribbon tab does not appear when you open Excel, please

follow these steps to troubleshoot the problem.

1. Per User Installation

The default installer does not require administrative privileges and will

install for only the currently logged in user. If you, or someone from

your IT department, logged in under an admin account to install

FlowBreeze, it will only be available in Excel to the admin login account.
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To fix this problem, there are two options: (1) Uninstall FlowBreeze and

reinstall it under the user's account. (2) Uninstall FlowBreeze, and then

download and install the admin installer from the BreezeTree

downloads page, which will install for all user profiles on the system. 

2. Check the Disabled Items list

Excel 2010 - 2016

· Click the File tab on the Excel ribbon.

· Click the 'Excel Options' button in the left menu.

· Click 'Add-Ins' in the left menu of the Excel Options window.

· Click the 'Manage' drop down, select 'Disabled Items' from the list,

then click the 'Go…' button.

· If FlowBreeze is listed, select it and click the 'Enable' button, then

restart Excel.

Excel 2007

· Click the Office Button in the upper left corner of Excel.

· Click the 'Excel Options' button on the bottom-right corner of the

window.

· Click 'Add-Ins' in the left menu of the Excel Options window.

· Click the 'Manage' drop down, select 'Disabled Items' from the list,

then click the 'Go…' button.

· If FlowBreeze is listed, select it and click the 'Enable' button, then

restart Excel.

3. Check the COM Add-ins list

Excel 2010 - 2016:

· Click the File tab on the Excel ribbon.

· Click the 'Excel Options' button in the left menu.



Support 131

© 2017 BreezeTree Software

· Click 'Add-Ins' in the left menu of the Excel Options window.

· Click the 'Manage' drop down, select 'COM Add-ins' from the list, then

click the 'Go…' button.

· If FlowBreeze3 is listed, make sure the checkbox next to it is

checked.

Excel 2007:

· Click the Office Button in the upper left corner of Excel.

· Click the 'Excel Options' button on the bottom-right corner of the

window.

· Click 'Add-Ins' in the left menu of the Excel Options window.

· Click the 'Manage' drop down, select 'COM Add-ins' from the list, then

click the 'Go…' button.

· If FlowBreeze3 is listed, make sure the checkbox next to it is

checked.

4. Check the security settings

Excel 2010 - 2016:

· Click the File tab on the Excel ribbon.

· Click the 'Excel Options' button in the left menu.

· Click "Trust Center" on the left navigation panel.

· Click the "Trust Center Settings" button.

· The "Message Bar" panel should be open by default. Make sure that

the "Show in Message Bar..." option is selected.

· Next, click "Add-Ins" from the left menu and set the options per the 

Add-ins Options section below.

Excel 2007:

· Click the Office Button in the upper left corner of Excel 2007.
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· On the bottom-right of the popup menu, click the "Excel Options"

button.

· Click "Trust Center" on the left navigation panel.

· Click the "Trust Center Settings" button.

· The "Message Bar" panel should be open by default. Make sure that

the "Show in Message Bar..." option is selected.

· Next, click "Add-Ins" from the left menu and set the following

options;

Add-ins Options

· Option 1:

o Check the box labeled "Require Application Add-ins to be signed by

Trusted Publisher"

oUncheck "Disable notification for unsigned add-ins"

oUncheck "Disable all Application Add-ins"

· Option 2: (not recommended)

o  Leave all the settings on this panel Unchecked.

Excel needs to be restarted for these security changes to take effect. If

you selected Option 1, then the next time you restart Excel, follow the

steps in Security Warning - Enable FlowBreeze (below).

5. Security Warning - Enable FlowBreeze (Excel 2007 - 2016)

If "Require Application Add-ins to be signed by Trusted Publisher" is

checked in the Excel Trust Center (see the section above)., you will see

a warning when you open Excel after installing FlowBreeze. The actions

differ slightly between Excel 2007 - 2016.

Excel 2010 - 2016:
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If you see the security message shown below, click the "Application

add-ins have been disabled" label. (Clicking "Enable Content" will

enable it only for the current session).

:

Excel will show the info screen below. Click the "Enable Content"

dropdown and select "Advanced Options".

On the security options dialog, select "Enable all code published by this

publisher" and click OK.
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Excel 2007:

If you see the security message shown below, click the "Options"

button.
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On the security options dialog select "Enable all code published by this

publisher" and click OK.

6. Installation - restart required

If Excel was running during the installation, it will need to be re-started

again for the FlowBreeze toolbar to display.

7. Download Source

Did you download the program from www.breezetree.com? The

BreezeTree website is the only official site for downloading FlowBreeze.

To get the latest version, download FlowBreeze only from www.

breezetree.com. Download sites (including popular ones such as

download.com) often host old versions of FlowBreeze. Downloading
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from any other site is not recommended.

If the above checks didn't reveal the problem, please contact

BreezeTree at support@breezetree.com. The following information

would be helpful to determine the root cause.

· If you click Start > All Programs, is FlowBreeze listed among the

applications?

· What version of Excel are you running?

· What Windows version are you running?

· Are you running any other add-ins in Excel?

12.4 How to Speed-Up Loading

For most users, FlowBreeze is not the kind of tool that you use everyday.

Every add-in that gets loaded into Excel can slow its startup. To speed

things up, you can load FlowBreeze on demand, or unload it when not in

use, via the COM Add-ins dialog in Excel, shown in the image below.

Toggling the checkbox next to FlowBreeze will load and unload the add-in.

COM Add-ins Dialog

The instructions below show how to gain quick access to this dialog.
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1.Click the down arrow next to the Quick Access Toolbar (QAT) and select

"More Commands ...", as shown in the image below.

QAT - More Commands

1.Under “Choose commands from” select “All Commands” from the drop

down list, and then scroll down and select the “COM Add-ins” item from

the list, as shown below.
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Adding COM Add-ins button to QAT

2.Click the Add button, and then OK to close.

The COM Add-ins button will now appear on your Quick Access Toolbar

(QAT). Clicking it will open a dialog that lets you load or unload

FlowBreeze (or any other COM add-in). When you’re not using

FlowBreeze, unloading it will probably let Excel startup faster, so this is a

handy tool.

COM Add-in Button on QAT
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12.5 Uninstalling FlowBreeze

FlowBreeze Versions  3 and 4

To uninstall FlowBreeze 3 from Vista or Windows 7, 8, or 10, please follow

these steps:

1.Open the Control Panel (see note below).

2.Double-click "Programs and Features".

3.Select FlowBreeze in the listings and click Uninstall from the top menu

bar.

Note. In Vista and Windows 7, the Control Panel is accessible via the

Windows Start menu. In Windows 8 and 10, hold down the Windows logo

button and press "X" on your keyboard, then select "Programs and

Features" from the popup menu.

To uninstall FlowBreeze 3 from Windows XP and 2000, please follow these

steps:

1.Open the Control Panel from the Windows Start menu.

2.Double-click Add or Remove Programs.

3.Select FlowBreeze in the listings and click Remove from the top menu

bar.

FlowBreeze Versions 1 and 2

To uninstall FlowBreeze 1.x or 2.x from any version of Windows, please

follow these steps:

1.Click the Windows Start button.

2.Click All Programs and navigate to the FlowBreeze group.

3.Click the Uninstall option and follow the prompts.
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If Version 2 Fails to Uninstall

If a permissions error occurs when uninstalling version 2, finding the root

cause can be hard to troubleshoot. However, there are three workarounds

that can be used.

Unregistering Versions 1 and 2 Manually

1.Close Excel if it is open.

2.Go to the Windows Start menu, navigate to Accessories, right-click on

Command Prompt, and select Run as Administrator.

3.Type "cd c:\program files (x86)\flowbreeze" to go to the installation

folder [omit the "(x86)" part of the path on 32-bit operating systems].

4.Type "regsvr32.exe /u flowbreeze.dll" and press enter.

Disabling Versions 1 and 2 within Excel

1.Open the Excel Options dialog.

· Excel 2010 - 2016: Click the File tab on the Excel ribbon, and then

click the "Excel Options" button in the left menu.

· Excel 2007: Office Button in the upper left corner of Excel, and then

click the "Excel Options" button on the bottom-right corner of the

window.

2.In the left menu, select "Add-ins".

3.From the "Manage" dropdown list, select "COM add-ins" and click the

"Go..." button.

4.If "FlowBreeze" is listed, uncheck the box. Note, version 3 of

FlowBreeze is listed as FlowBreeze3. Do not uncheck that if you want

FlowBreeze3 to remain running.

5.Click OK. The add-in will take up a minor amount of space on your hard

drive but will be rendered non-functional.
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Disabling Versions 1 and 2 in the Windows Registry

This step requires administrative privileges.

1.Close Excel if it is open.

2.In the Windows Start menu, enter "regedit" in the search bar and press

enter.

3.You will be prompted with a User Account Control. Click OK.

4.Navigate to

HKEY_CURRENT_USER\Software\Microsoft\Office\Excel\Addins\FlowBre

eze.dsrConnect.

5.Double-click the LoadBehavior value and change the value to 0 (zero).

6.Close the registry.
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13 How to Buy

Purchasing Options

FlowBreeze is available for purchase ...

· Through the BreezeTree website (www.breezetree.com). We accept

payments using most major credit cards, wire transfer, and PayPal.

· Via Purchase Order (see Purchase Orders and Quotes, below).

Purchase Orders and Quotes

BreezeTree Software accepts purchase orders for amounts of $100  or

more for customers within the United States. Please contact

sales@breezetree.com if you would like to place an order via P.O. or need

a formal quote. The standard terms are Net 30. The method of delivery is

electronic (i.e., download).

W-9 Statements

A W-9 is available upon request. Please contact sales@breezetree.com to

obtain a copy.
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